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> Preface

Preface

Thank you for purchasing this machine.

This Operation Guide is intended to help you operate the machine correctly, perform routine maintenance, and take
simple troubleshooting measures as needed so that the machine can always be used in the optimum condition.

Please read this Operation Guide before using the machine.

To maintain quality, we recommend using genuine Kyocera toner containers, which must
pass numerous quality inspections.

The use of non-genuine toner containers may cause failure.
We will not be liable for any damages caused by the use of third party supplies in this machine.

A label is affixed to our genuine supplies, as shown below.

/ i -

O] KYOCERA

A

Checking the Equipment's Serial Number

The equipment's serial number is printed in the location shown in the figure.

+INRNNNNNNE*

You'll need the equipment's serial number when contacting your Service Representative. Please check the number
before contacting your Service Representative.
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> Machine Features

Machine Features

The machine is equipped with many useful functions.

Here are some examples.

Save energy and cost

Save energy as needed
(Energy Saver function)

The machine is equipped with Energy
Saver function that automatically
switched into Sleep Mode.

= Fnergy Saver function (page 2-29)

Use less toner for printing
(EcoPrint)

>

You can save toner consumption with this
function.

When you only need to check the printed
content, such as a trial print run or
documents for internal confirmation, use
this function to save toner.

Use this function when a high-quality print
is not required.

= EcoPrint Mode (page 6-9)

Reduce paper use
(Paper Saving Printing)

B

You can print originals on both sides of
the paper. You can also print multiple
originals onto one sheet.

Strengthen security

Prevent loss of finished documents
(Private Print)

You can temporarily save a printer
document in the machine. By printing the
document from the machine prevents
someone takes your document.

®» Printing Data Saved in the Printer
(page 4-11)

Log in by ID card
(Card Authentication)

OK'!

You can log in simply by touching an ID
card. You don't need to enter the
administrator name and password.

®» Card Authentication Kit(B) "Card
Authentication Kit" (page 9-2)

Strengthen security
(Settings for Administrator)

M
t

Various functions are available for
administrators to strengthen security.

®» Strengthening the Security (page 2-44)

Vi




> Machine Features

Use functions more efficiently

Make the machine quiet
(Quiet Mode)

You can make the machine quiet by
reducing its running noise. ON/OFF
switching by one-touch is possible.

P Quiet Mode (page 2-32)

Install the machine without concerning
the network cables (Wireless Network)

If there is a wireless LAN environment, it
is possible to install the unit without
worrying about the network wiring. In
addition, Wi-Fi Direct, etc. are supported.

® Configuring the Wireless Network

(page 2-19)
Setting Wi-Fi Direct (page 2-26)

Use USB drive
(USB Drive)

& —

It is useful when you need to print
document outside your office or you
cannot print document from your PC.

You can print the document from the USB
drive by plugging it directly into the
machine.

® Printing Documents Stored in
Removable USB Drive (page 5-7)

Use functions more efficiently

Perform remote operation
(Command Center RX)

ErTC

You can access to the machine remotely
to print, send or download data.

Administrators can configure the machine
behavior or management settings.

= Command Center RX (page 2-45)

Vii




> Guides Provided with the Machine

Guides Provided with the Machine

The following guides are provided with the machine. Refer to each guide as needed.

The contents of the guides are subject to change without notice for the purpose of improvement of machine

performance.
Printed guides

Start using the
machine quickly

For safe use of the
machine

>

Quick Guide

Explains how to use basic functions of the machine, how to use convenient features, how
to perform routine maintenance, and what to do when problems occur.

Safety Guide

Provides safety and cautionary information for installation environment and use of the
machine. Be sure to read this guide before using the machine.

Safety Guide (ECOSYS PA2100cwx/ECOSYS PA2100cx)

Indicates the space required for machine installation, and describes the cautionary labels
and other safety information. Be sure to read this guide before using the machine.

Guides (PDF) on our website

Use the machine
thoughtfully

Use the ID card

Easily register
machine information
and configure settings

Print data from a
computer

Directly print a PDF file

Monitor the machine
and printers on the
network

Print without using the
printer driver

Adjust the print
position

Confirm the
information for Open
Source Software (OSS)

Work using the
machine remotely from
your home

>

vV v vVv Vv Vv

v

>

>

Operation Guide (This Guide)

Explains how to load paper and perform basic operations, and indicates default settings
and other information.

Card Authentication Kit (B) Operation Guide

Explains how to perform authentication using the ID card.

Command Center RX User Guide

Explains how to access the machine from a Web browser on your computer to check and
change settings.

Printer Driver User Guide
Explains how to install the printer driver and use the printer function.

KYOCERA Net Direct Print Operation Guide

Explains how to print PDF files without launching Adobe Acrobat or Reader.

KYOCERA Net Viewer User Guide

Explains how to monitor your network printing system (the machine) with KYOCERA Net
Viewer.

PRESCRIBE Commands Command Reference
Describes the native printer language (PRESCRIBE commands).

PRESCRIBE Commands Technical Reference

Describes the PRESCRIBE command functions and control for each type of emulation.

Maintenance Menu User Guide
Maintenance Menu provides the explanation on how to configure the print settings.

OSS Notice

Describes the information including license statements of Open Source Software used in
our product.

Kyocera Remote Work Assistant User Guide

Explains how to use the Kyocera Remote Work Assistant application to view the counter
information, send fax remotely and store image/job logs.

Install the following versions of Adobe Reader to view the manuals.

Version 8.0 or later

viii



> About the Operation Guide (this Guide)

About the Operation Guide (this Guide)

Structure of the guide

The Operation Guide contains the following chapters.

Chapter Contents

1 | Legal and Safety Information Provides precautions regarding use of the machine and trademark information.
2 | Installing and Setting up the Explains part names, cable connections, installation of the software, login, logout, and
Machine other matters related to administration of the machine.
3 | Preparation before Use Explains preparations and settings that are required in order to use the machine, such
as how to load paper.
4 | Printing from PC Explains the basic steps for printing.
5 | Operation on the Machine Explains the basic procedures for using document boxes.
6 | Setup and Registration (System | Explains System Menu and how it relates to the operation of the machine.
Menu)
7 | User Authentication and Explains user login and job accounting.
Accounting (User Login, Job
Accounting)
8 | Troubleshooting Explains what to do when toner runs out, an error is displayed, or a paper jam or other
problem occurs.
9 | Appendix Describes convenient options that are available for the machine. Provides information
on media types and paper sizes, and gives a glossary of terms. Explains lists the
specifications of the machine.




> About the Operation Guide (this Guide)

Conventions Used in This Guide

Adobe Reader Xl is used as an example in the explanations below.

Click an item in the Table of
Contents to jump to the
corresponding page.

Click to move from the current page to the previously

displayed page. This is convenient when you want to return

to the page from which you jumped to the current page.

Comment

[P Machine Features

[P Guides Provided with the
Machine

&P About the Operation
Guide (this Guide)

[ Menu Map

2 1 Legal and Safety
Information

&fF 2 Installing and Setting
up the Machine

=[F 3 Preparation before Use
2 4 Printing from PC

s Operation on the
Machine

2 6 Using Various Functions

= 7 Status/Job Cancel

& [P 8 Setup and Registration
(System Menu)

[P 9 User Authentication
and Accounting (User
Login, Job Accounting)

@{F 10 Troubleshooting

@ [P 11 Appendix

@@@@u%"'l:l/ @ ‘-+|‘:!7 TooIS'Sign;
[ Bookmarks
‘EJ E [II Preparation before Use > Loading Paper
E3- (& . .
EP Precaution for Loading Paper
= (g Contents When you open a new package of paper, fan the sheets to separate them slightly prior to loading in the following steps.
\é [P overview

In addition, note the following points

« If the paper is curled or folded, straighten it before loading, Paper that is curled or folded
may cause a jam.

+ Avoid exposing opened paper to high humidity as dampness can be a cause of problems.
Seal any remaining paper after loading in the multi purpose tray or cassttes back in the
paper storage bag.

+ I the machine will not be used for a prolonged period, protect ail paper from humidity by
removing it from the cassettes and sealing it in the paper storage bag

©@
1f you copy onto used paper (paper already used for printing), do not use paper that is
stapled or clipped together. This may damage the machine or cause poor image
quality.

[ note

Note the some paper types have a tendency o curl and may jam in the paper eject nit
If you use special paper such as letterhead, paper with holes or paper with pre-prints like
Iogo or company name, refer to the following

* Pager (page 11-13)

I @ IMPORTANT

Indicates operational requirements
and restrictions to operate the
machine correctly, and avoid
damage to the machine or property.

NOTE
Indicates supplemental

explanations and reference
information for operations.

ACAUTION

The fixing unit is extremely hot. Take sufficient care when working in this area, as.
there is a danger of getting burned.

Refer to

Click the underlined text to jump to
the corresponding page.

ACAUTION

Indicates that personal injury or
mechanical damage may result
from insufficient attention to or

NOTE

incorrect compliance with the
related points.

The items that appear in Adobe Reader vary depending on how it is used. If the Table of Contents or tools do not

appear, refer to Adobe Reader Help.

Certain items are indicated in this guide by the conventions described below.

Convention Description

[Bold]

Indicates keys and buttons.

"Regular”

Indicates a message or setting.




> About the Operation Guide (this Guide)

Conventions used in procedures for operating the machine

In this Operation Guide, continuous operation is as follows:

Actual procedure Procedure indicated in this guide
Select the [Menu] key. [Menu] key > [A][V¥] key > [Device Common] > [P ] key
v
Select the [A] or [¥] key to select [Device Common].
v
Select the [ ] key.

Size and Orientation of Paper

Paper sizes such as A5 and Statement can be used in both the horizontal and vertical orientations. To distinguish the
orientations when these sizes are used, "R" is added to sizes used in the vertical orientation.

Orientation Setting Position Indicated size in this Guide"
(X=Length, Y=Width)
Vertical orientation (-R) | Cassette X A5-R, Statement-R
Y
Multipurpose tray A5-R, Statement-R
X
| |
T
Horizontal orientation Cassette X A5
Y
Multipurpose tray A5, Statement
X
| |
T

*1 Paper sizes that can be used vary depending on the function and source tray. For details, refer to the following.
% Specifications (page 9-16)

Xi



> Menu Map

Menu Map

This is a list of menus displayed on the message display. Depending on the settings, some menus may not be displayed.
Some menu names may differ from their reference titles.

MENU

v

Report Print Print Menu Map (page 6-4)

Print Status Page (page 6-4)

Print Fonts List (page 6-5)

Print RAM Disk File List (page 6-5)

Print SD Card File List (page 6-5)

Print Data Sanitization Report (page 6-5)

USB Drive Print File (page 5-7)

Copies (page 5-7)

Paper Source (page 5-7)

Remove Device (page 5-8)

Print File List (page 5-8)

Job Box Quick Copy (page 4-12)

Private/Stored (page 4-14)

Job Box Quick Copy (page 4-16)

Delete (page 4-16)

Counter (page 2-43)

Paper Settings MP Tray Size (page 6-6)

MP Tray Type (page 6-6)

Cassette1 Size (page 6-6)

Cassette2 Size (page 6-6)

Cassette 1 Type (page 6-6)

Cassette 2 Type (page 6-6)

Type Adjust Paper Weight (page 6-7)

Duplex Path (page 6-7)

Reset Type Adjust (page 6-6)

Paper Setup Msg (page 6-6)

Xii



> Menu Map

Print Settings

Paper Source (page 6-8)

Auto Cass.Change (page 6-8)

MP Tray Priority (page 6-8)

Paper Feed Mode (page 6-8)

Duplex (page 6-8)

Override A4/LT (page 6-8)

Emulation

Error Report (page 6-8)

Color Mode (page 6-8)

Print Quality

Gloss Mode (page 6-9)

EcoPrint Mode (page 6-9)

Resolution (page 6-9)

Page Set

Copies (page 6-9)

Orientation (page 6-9)

Wide A4 (page 6-9)

XPS FitTo Page (page 6-9)

TIFF/JPEG Size (page 6-9)

User Name (page 6-9)

Job Name (page 6-9)

Job Terminator (page 6-9)

Wi-Fi Direct Set

Wi-Fi Direct (page 6-10)

Auto Disconnect

Timer (Day:Hour:Min) (page 6-10)

Wi-Fi Settings

Wi-Fi (page 6-10)

Quick Setup (page 6-10)

TCP/IP

DHCP (page 6-11)

Auto-IP (page 6-11)

IP Address (page 6-11)

Subnet Mask (page 6-11)

Gateway (page 6-11)

TCP/IP (IPv6)

RA(Stateless) (page 6-12)

DHCPV6 (page 6-12)

Restart Network (page 6-12)

Xiii




> Menu Map

Wired Network

TCP/IP

DHCP (page 6-11)

Auto-IP (page 6-11)

IP Address (page 6-11)

Subnet Mask (page 6-11)

Gateway (page 6-11)

TCP/IP (IPv6)

RA(Stateless) (page 6-12)

DHCPV6 (page 6-12)

LAN Interface (page 6-12)

Restart Network (page 6-12)

Network Settings

Communication (page 6-13)

SSL Server (page 6-13)

IPSec (page 6-13)

Bonjour (page 6-13)

NetBEUI (page 6-13)

SNMPv3 (page 6-13)

FTP(Server) (page 6-13)

SNMP (page 6-14)

SMTP (page 6-14)

POP3 (page 6-14)

RAW_Port (page 6-14)

LPD (page 6-14)

IPP (page 6-14)

IPP over SSL (page 6-14)

HTTP (page 6-15)

HTTPS (page 6-15)

ThinPrint (page 6-15)

ThinPrint over SSL (page 6-16)

WSD-PRINT (page 6-16)

Enhanced_WSD (page 6-16)

EnhancedWSD(SSL) (page 6-16)

Xiv




> Menu Map

Device Common

Security

Message Language (page 6-17)

Date Setting

Date (Year/Mon/Day) (page 6-17)

Time (Hour:Min:Sec) (page 6-17)

Date Format (page 6-17)

Time Zone (page 6-17)

Summer Time (page 6-17)

Buzzer

Key Confirmation (page 6-18)

Job End (page 6-18)

Ready (page 6-18)

Error (page 6-18)

RAM Disk Mode

RAM Disk Size (page 6-18)

SD Card

Format (page 6-18)

Error Handling

Duplex (page 6-19)

Paper Mismatch (page 6-19)

MP Tray Empty (page 6-19)

ColorToner Empty (page 6-19)

Timer

Auto Panel Reset (page 6-19)

Panel Reset Timer (page 6-19)

Sleep Timer (page 6-19)

Auto Error Clear (page 6-20)

Error Clear Timer (page 6-20)

Form Feed Time Out (page 6-20)

Sleep Level Set.

Sleep Level (models except for Europe)
(page 6-20)

Network (page 6-20)

Card Reader (page 6-20)

Power Off Rule

Network (page 6-20)

USB Cable (page 6-20)

USB Host (page 6-21)

RAM Disk (page 6-21)

Power Off Timer (page 6-21)

Disp. Status/Log

JobsDetailStatus (page 6-21)

Jobs Log (page 6-21)

Low Toner Alert (page 6-21)

I/F Block

USB Host (page 6-22)

USB Device (page 6-22)

USB Storage (page 6-22)

XV




> Menu Map

Security Security Level (page 6-22)
DataSanitization (page 6-23)
User/Job Account User Login Set. Login Type (page 7-3)

Key Login (page 7-4)

Job Accounting (page 7-7)

AccountingAccess (page 7-8)

Select Account

Counter (page 7-17)

Color Counter (page 7-17)

Restriction (page 7-11)

Color Restriction (page 7-11)

Maximum Output (page 7-11)

Color Max. Output (page 7-11)

Reset Counter (page 7-17)

Add Account (page 7-9)

Delete Account (page 7-14)

Print Job Accounting List (page 7-17)

Apply Limit (page 7-20)

Unknown ID Job (page 7-21)

Administrator

Change ID (page 7-22)

Change Password (page 7-22)

Adjust/Maintenance

Color Calibration (page 6-24)

Registration Normal (page 6-24)

Registration Details (page 6-24)

Managed by Admin (page 6-24)

Restart Printer (page 6-24)

Service (page 6-24)

Op functions (page 6-23)

Wired Status (page 6-24)

Wi-Fi Status NetwkName(SSID) (page 6-25)
Wi-Fi Direct PushButton Setup (page 6-26)

Device Name (page 6-26)

NetwkName (SSID) (page 6-26)

Password (page 6-26)

IP Address (page 6-26)

Netwk Authentic (page 6-26)

Data Encryption (page 6-26)

Disconnect All (page 6-26)

XVi




1 Legal and Safety
Information

Please read this information before using your machine. This chapter provides information on the following topics.
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Legal and Safety Information > Notice

Notice

Safety Conventions in This Guide

The sections of this guide and parts of the machine marked with symbols are safety warnings meant to protect the user,
other individuals and surrounding objects, and ensure correct and safe usage of the machine. The symbols and their
meanings are indicated below.

WARNING: Indicates that serious injury or even death may result from insufficient
A attention to or incorrect compliance with the related points.

CAUTION: Indicates that personal injury or mechanical damage may result from
A insufficient attention to or incorrect compliance with the related points.

Symbols

The A symbol indicates that the related section includes safety warnings. Specific points of attention are indicated

inside the symbol.
A ... [General warning]

& ... [Warning of high temperature]

The © symbol indicates that the related section includes information on prohibited actions. Specifics of the prohibited
action are indicated inside the symbol.

® ... [Warning of prohibited action]

® ... [Disassembly prohibited]

The ® symbol indicates that the related section includes information on actions which must be performed. Specifics of
the required action are indicated inside the symbol.

o ... [Alert of required action]
% ... [Remove the power plug from the outlet]

9 ... [Always connect the machine to an outlet with a ground connection]

Please contact your service representative to order a replacement if the safety warnings in this Operation Guide are
illegible or if the guide itself is missing (fee required).
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Environment

The service environmental conditions are as follows:
Temperature 50 to 90.5°F (10 to 32.5°C)
Humidity 10 to 80%

Avoid the following locations when selecting a site for the machine.

* Avoid locations near a window or with exposure to direct sunlight.

* Avoid locations with vibrations.

* Avoid locations with drastic temperature fluctuations.

» Avoid locations with direct exposure to hot or cold air.

* Avoid poorly ventilated locations.

If the floor is delicate against casters, when this machine is moved after installation, the floor material may be damaged.

During printing, some ozone is released, but the amount does not cause any ill effect to one's health. If, however, the
machine is used over a long period of time in a poorly ventilated room or when making an extremely large number of
prints, the smell may become unpleasant. To maintain the appropriate environment for print work, it is suggested that the
room be properly ventilated.
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Precautions for Use

Cautions when handling consumables

A CAUTION

Do not attempt to incinerate parts which contain toner. Dangerous sparks may cause burns.
Keep parts which contain toner out of the reach of children.

If toner happens to spill from parts which contain toner, avoid inhalation and ingestion, as well as contact with your eyes
and skin.

+ If you do happen to inhale toner, move to a place with fresh air and gargle thoroughly with a large amount of water. If
coughing develops, contact a physician.

» If you do happen to ingest toner, rinse your mouth with water and drink 1 or 2 cups of water to dilute the contents of
your stomach. If necessary, contact a physician.

» If you do happen to get toner in your eyes, flush them thoroughly with water. If there is any remaining tenderness,
contact a physician.

 If toner does happen to get on your skin, wash with soap and water.

Do not attempt to force open or destroy parts which contain toner.

Other precautions

Return the exhausted toner container to your dealer or service representative. The collected toner container will be
recycled or disposed in accordance with the relevant regulations.

Store the machine while avoiding exposure to direct sunlight.

Store the machine in a place where the temperature stays below 40°C while avoiding sharp changes of temperature and
humidity.

If the machine will not be used for an extended period of time, remove the paper from the cassette and the Multipurpose
(MP) Tray, return it to its original package and reseal it.

1-4



Legal and Safety Information > Notice

Laser Safety (Europe)

Laser radiation could be hazardous to the human body. For this reason, laser radiation emitted inside this machine is
hermetically sealed within the protective housing and external cover. In the normal operation of the product by user, no
radiation can leak from the machine.

This machine is classified as Class 1 laser product under IEC/EN 60825-1:2014.

Regarding CLASS 1 laser products, information is provided on the rating label.

4 )

CLASS 1 LASER PRODUCT

KLASSE 1 LASER PRODUKT
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SAFETY OF LASER BEAM (USA)

1. Safety of laser beam

This machine has been certified by the manufacturer to Class 1 level under the radiation performance standards
established by the U.S.DHHS (Department of Health and Human Services) in 1968. This indicates that the product is
safe to use during normal operation and maintenance. The laser optical system, enclosed in a protective housing and
sealed within the external covers, never permits the laser beam to escape.

2. The CDRH Act

A laser-product-related act was implemented on Aug. 2, 1976, by the Center for Devices and Radiological Health
(CDRH) of the U.S. Food and Drug Administration (FDA). This act prohibits the sale of laser products in the U.S. without
certification, and applies to laser products manufactured after Aug. 1, 1976. The label shown below indicates
compliance with the CDRH regulations and must be attached to laser products marketed in the United States. The
position of the rating label is show below.

ECOSYS xxxxxxxx

3. Maintenance

For safety of the service personnel, follow the maintenance instructions in the other section of this manual.

4. Safety switch

The power to the laser unit is cut off when the front cover is opened.
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Safety Instructions Regarding the Disconnection of
Power

Caution: The power plug is the main isolation device! Other switches on the equipment are only functional switches and
are not suitable for isolating the equipment from the power source.

Attention: Le débranchement de la fiche secteur est le seul moyen de mettre I'appareil hors tension. Les interrupteurs
sur l'appareil ne sont que des interrupteurs de fonctionnement: ils ne mettent pas I'appareil hors tension.

Compliance and Conformity

Hereby, KYOCERA Document Solutions Inc. declares that the radio equipment type ECOSYS PA2100cwx is in compliance
with Directive 2014/53/EU.

The full text of the EU declaration of conformity is available at the following internet address:

https://www.kyoceradocumentsolutions.eu/index/service/dlc.html

Software Ver. Frequency band in Maximum radio-frequency power transmitted in the
which the radio frequency band in which the radio equipment
equipment operates: operates:
2014.12 2.4GHz 100mW

NOTE — Use shielded interface cables.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 and
Part 18 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

» The use of a non-shielded interface cable with the referenced device is prohibited.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device
may not cause harmful interference, and (2) this device must accept any interference received, including interference
that may cause undesired operation.

IMPORTANT NOTE:

Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This equipment
should be installed and operated with minimum distance 20cm between the radiator & your body.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.
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Industry Canada statement:

This device contains licence-exempt transmitter(s) / receiver(s) that complies with Innovation, Science and Economic
Development Canada’s licence-exempt RSS (s). Operation is subject to the following two conditions:

(1) This device may not cause interference.
(2) This device must accept any interference, including interference that may cause undesired operation of the device.

The antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all
persons and must not be co-located or operating in conjunction with any other transmitter.

Industry Canada ICES-003 Compliance Label: CAN ICES-3B/NMB-3B
NOTE — Use shielded interface cables.

Radiation Exposure Statement:

This equipment complies with Canada radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20cm between the radiator & your body.

For Singapore (ECOSYS PA2100cwx only)

Complies with
IMDA Standards
DB01846

Other precautions
(for users in California, the United States)

Perchlorate Material - special handling may apply. See www.dtsc.ca.gov/hazardouswaste/perchlorate.

Wireless Connection (Mexico only)

The operation of this equipment is subject to the following two conditions:

(1) itis possible that this equipment or device may not cause harmful interference, and (2) this equipment or device must
accept any interference, including interference that may cause undesired operation.

La operacion de este equipo esta sujeta a las siguientes dos condiciones:

(1) es posible que este equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe
aceptar cualquier interferencia, incluyendo la que pueda causar su operacion no deseada.

Security Precautions when Using Wireless LAN
(If equipped)

Wireless LAN allows information to be exchanged between wireless access points instead of using a network cable,
which offers the advantage that a LAN connection can be established freely within an area in which radio waves can be
transmitted.

On the other hand, the following problems may occur if security settings are not configured, because radio waves can
pass through obstacles (including walls) and reach everywhere within a certain area.
Secretly Viewing Communication Contents

A third person with malicious objectives may intentionally monitor radio waves and gain unauthorized access to the
following communication contents.

* Personal information including ID, passwords, and credit card numbers
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* Contents of email messages

lllegal Intrusion

A third party with malicious intent may gain unauthorized access to personal or company networks and conduct the
following illegal actions.

» Extracting personal and confidential information (information leak)

» Entering into communication while impersonating a specific person and distributing unauthorized information
(spoofing)

* Modifying and retransmitting intercepted communications (falsification)

* Transmitting computer viruses and destroying data and systems (destruction)

Wireless LAN cards and wireless access points contain built-in security mechanisms to address these problems and to
reduce the possibility of these problems occurring by configuring the security settings of wireless LAN products when
the product is used.

We recommend that customers take responsibility and use their judgment when configuring the security settings and
that they ensure that they fully understand the problems that can occur when the product is used without configuring the
security settings.

Limited Use of This Product (If equipped)

» Radio waves transmitted from this product may affect medical equipment. When using this product in a medical
institution or in the vicinity of medical instruments, either use this product according to the instructions and
precautions provided by the administrator of the institution or those provided on the medical instruments.

» Radio waves transmitted from this product may affect automatic control equipment including automatic doors and fire
alarms. When using this product in the vicinity of the automatic control equipment, use this product according to the
instructions and precautions provided on the automatic control equipment.

« If this product is used in devices that are directly related to service including airplanes, trains, ships, and automobiles
or this product is used in applications requiring high reliability and safety to function and in devices requiring accuracy
including those used in disaster prevention and crime prevention and those used for various safety purposes, please
use this product after considering the safety design of the entire system including adoption of a failsafe design and
redundancy design for reliability and safety maintenance of the entire system. This product is not intended for use in
applications requiring high reliability and safety including aerospace instruments, trunk communication equipment,
nuclear power control equipment, and medical equipment; hence, the decision as to whether to use this product in
these applications needs to be fully considered and determined.
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Legal Information

Copying or other reproduction of all or part of this guide without the prior written consent of KYOCERA Document
Solutions Inc. is prohibited.

Regarding Trade Names
+ PRESCRIBE and ECOSYS are registered trademark of Kyocera Corporation.

+ KPDL is a trademark of Kyocera Corporation.

* Microsoft, Windows, Windows XP, Windows Server 2003, Windows Vista, Windows Server 2008, Windows 7,
Windows Server 2012, Windows 8, Windows 8.1, Windows 10 and Internet Explorer are registered trademarks or
trademarks of Microsoft Corporation in the U.S.A. and/or other countries.

* PCL is a trademark of Hewlett-Packard Company.

* Adobe Acrobat, Adobe Reader and PostScript are trademarks of Adobe Systems Incorporated.

» Ethernet is a registered trademark of Xerox Corporation.

* Novell and NetWare are registered trademarks of Novell, Inc.

* IBM and IBM PC/AT are trademarks of International Business Machines Corporation.

» AppleTalk, Bonjour, Macintosh, and Mac OS are trademarks of Apple Inc., registered in the U.S. and other countries.

» All European language fonts installed in this machine are used under licensing agreement with Monotype Imaging
Inc.

* Helvetica, Palatino and Times are registered trademarks of Linotype GmbH.

* ITC Avant Garde Gothic, ITC Bookman, ITC ZapfChancery and ITC ZapfDingbats are registered trademarks of
International Typeface Corporation.

» ThinPrint is a trademark of Cortado AG in Germany and other countries.

+ UFST™ MicroType® fonts by Monotype Imaging Inc. are installed in this machine.

» This machine contains the software having modules developed by Independent JPEG Group.

+ iPad, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and other countries.
* AirPrint and the AirPrint logo are trademarks of Apple Inc.

» i0OS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license by
Apple Inc.

* Google is a trademark of Google LLC.
* Mopria™ is registered trademarks of Mopria™ Alliance.
* Wi-Fi and Wi-Fi Direct are trademarks and/or registered trademarks of Wi-Fi Alliance.

All other brands and product names are registered trademarks or trademarks of their respective companies. The
designations ™ and ® will not be used in this Operation Guide.
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Monotype Imaging License Agreement

1 Software shall mean the digitally encoded, machine readable, scalable outline data as encoded in a special format as
well as the UFST Software.

2 You agree to accept a non-exclusive license to use the Software to reproduce and display weights, styles and
versions of letters, numerals, characters and symbols (Typefaces) solely for your own customary business or
personal purposes at the address stated on the registration card you return to Monotype Imaging. Under the terms of
this License Agreement, you have the right to use the Fonts on up to three printers. If you need to have access to the
fonts on more than three printers, you need to acquire a multiuser license agreement which can be obtained from
Monotype Imaging. Monotype Imaging retains all rights, title and interest to the Software and Typefaces and no rights
are granted to you other than a License to use the Software on the terms expressly set forth in this Agreement.

3 To protect proprietary rights of Monotype Imaging, you agree to maintain the Software and other proprietary
information concerning the Typefaces in strict confidence and to establish reasonable procedures regulating access
to and use of the Software and Typefaces.

4 You agree not to duplicate or copy the Software or Typefaces, except that you may make one backup copy. You
agree that any such copy shall contain the same proprietary notices as those appearing on the original.

5 This License shall continue until the last use of the Software and Typefaces, unless sooner terminated. This License
may be terminated by Monotype Imaging if you fail to comply with the terms of this License and such failure is not
remedied within thirty (30) days after notice from Monotype Imaging. When this License expires or is terminated, you
shall either return to Monotype Imaging or destroy all copies of the Software and Typefaces and documentation as
requested.

6 You agree that you will not modify, alter, disassemble, decrypt, reverse engineer or decompile the Software.

Monotype Imaging warrants that for ninety (90) days after delivery, the Software will perform in accordance with
Monotype Imaging-published specifications, and the diskette will be free from defects in material and workmanship.
Monotype Imaging does not warrant that the Software is free from all bugs, errors and omissions.

The parties agree that all other warranties, expressed or implied, including warranties of fitness for a particular
purpose and merchantability, are excluded.

8 Your exclusive remedy and the sole liability of Monotype Imaging in connection with the Software and Typefaces is
repair or replacement of defective parts, upon their return to Monotype Imaging.

In no event will Monotype Imaging be liable for lost profits, lost data, or any other incidental or consequential
damages, or any damages caused by abuse or misapplication of the Software and Typefaces.

9 Massachusetts U.S.A. law governs this Agreement.

10 You shall not sublicense, sell, lease, or otherwise transfer the Software and/or Typefaces without the prior written
consent of Monotype Imaging.

11 Use, duplication or disclosure by the Government is subject to restrictions as set forth in the Rights in Technical Data
and Computer Software clause at FAR 252-227-7013, subdivision (b)(3)(ii) or subparagraph (c)(1)(ii), as appropriate.
Further use, duplication or disclosure is subject to restrictions applicable to restricted rights software as set forth in
FAR 52.227-19 (c)(2).

12 You acknowledge that you have read this Agreement, understand it, and agree to be bound by its terms and
conditions. Neither party shall be bound by any statement or representation not contained in this Agreement. No
change in this Agreement is effective unless written and signed by properly authorized representatives of each party.
By opening this diskette package, you agree to accept the terms and conditions of this Agreement.

Open Source Software License

For the “Open Source Software license, go into the following URL and select Country > Product Name > OS > Language
and then, refer to the “OSS_Notice” from the manual tab in the “Download”.
https://kyocera.info/
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Energy Saving Control Function

The device comes equipped with a Sleep where printer functions remain in a waiting state but power consumption is
reduced to a minimum after a certain amount of time elapses since the device was last used. If the machine is not used
while in sleep mode, the power automatically turns off.

® Auto Sleep (page 2-29)
Power Off Rule (models for Europe) (page 6-20)

Automatic 2-Sided Print Function

This device includes 2-sided printing as a standard function. For example, by printing two 1-sided originals onto a single
sheet of paper as a 2-sided print, it is possible to lower the amount of paper used.

Printing in duplex mode reduces paper consumption and contributes to the conservation of forest resources. Duplex
mode also reduces the amount of paper that must be purchased, and thereby reduces cost. It is recommended that
machines capable of duplex printing be set to use duplex mode by default.

Resource Saving - Paper

For the preservation and sustainable use of forest resources, it is recommended that recycled as well as virgin paper

certified under environmental stewardship initiatives or carrying recognised ecolabels, which meet EN 12281 :2002" or
an equivalent quality standard, be used.

This machine also supports printing on 64 g/m2 paper. Using such paper containing less raw materials can lead to
further saving of forest resources.
* 1 EN12281:2002 "Printing and business paper - Requirements for copy paper for dry toner imaging processes"

Your sales or service representative can provide information about recommended paper types.

Environmental benefits of "Power Management”

To reduce power consumption when idle, this machine is equipped with a power management function that
automatically activates energy-saving mode when the machine is idle for a certain period of time.

Although it takes the machine a slight amount of time to return to READY mode when in energy-saving mode, a
significant reduction in energy consumption is possible. It is recommended that the machine be used with the activation
time for energy-saving mode set to the default setting.

Energy Star (ENERGY STAR®) Program

We patrticipate in the ENERGY STAR® Program.

We provide the products complied with ENERGY STAR® to the market.

ENERGY STAR® is an energy efficiency program with the goal of developing and promoting the use of
products with high energy efficiency in order to help prevent global warming. By purchasing the products
ENERGY STAR complied with ENERGY STAR®, customers can help reduce emissions of greenhouse gases during
product use and cut energy-related costs.




2 Installing and Setting
up the Machine

This chapter provides information for the administrator of this machine, such as part names, cable connection, and
software installation.
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Installing and Setting up the Machine > Part Names (Machine Exterior)

Part Names (Machine Exterior)

1 Top Tray 6 Button (Right Cover Open)
2 Paper Stopper 7 USB Port

3 Cassette 1 8 Right Cover

4 Power Switch 9 Operation Panel

5 Handles 10 Anti-theft Lock Slot

11 Rear Cover 1
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Installing and Setting up the Machine > Part Names (Connectors/Interior)

Part Names (Connectors/Interior)

a b W N -

USB Interface Connector

Network Interface Connector
Feed Cover

Paper Length Guide

Paper Width Guides

6 Multipurpose Tray
7 Tray Extension
8 Paper Width Guides

9 Fuser Cover
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Installing and Setting up the Machine > Part Names (Connectors/Interior)

10111213
10 Toner Container (Yellow) 13 Toner Container (Black)
11 Toner Container (Cyan) 14 Toner Container Lock Lever

12 Toner Container (Magenta)



Installing and Setting up the Machine > Part Names (With Optional Equipments Attached)

Part Names (With Optional Equipments
Attached)

1 Cassette 2
2 Rear Cover 2

® Optional Equipment (page 9-2)
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Installing and Setting up the Machine > Connecting the Machine and Other Devices

Connecting the Machine and Other Devices

Prepare the cables necessary to suit the environment and purpose of the machine use.

When Connecting the Machine to the PC via USB

@ USB

When Connecting the Machine to the PC or Tablet by network cable, Wi-Fi, or Wi-Fi direct

Network cable
connection
1
Wi-Fi
connection™!
1
Wi-Fi access point
Wi-Fi Direct
Tablet R
ave .\\ connection™
1

*1  Only for models with Wi-Fi.

NOTE

If you are using wireless LAN, refer to the following.

® Configuring the Wireless Network (page 2-19)

Cables that Can Be Used

Connection Environment Function Necessary Cable
Connect a LAN cable to the Printer LAN cable (10BASE-T, 100BASE-TX,
machine. 1000BASE-T)

Connect a USB cable to the Printer USB 2.0 compatible cable (Hi-Speed USB
machine. compliant, max. 5.0 m, shielded)

(&) IMPORTANT
Using a cable other than a USB 2.0 compatible cable may cause failure.
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Installing and Setting up the Machine > Connecting Cables

Connecting Cables

Connecting LAN Cable

() IMPORTANT
Make sure that the power to the machine is turned off.

® Power Off (page 2-9)

1 Connect the cable to the machine.

1 Connect the LAN cable to the network interface connector.

- 150

=
t
g

[

2 Connect the other end of the cable to the hub or the PC.

2 Power on the machine and configure the network.
2 Network Setup (page 2-17)
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Installing and Setting up the Machine > Connecting Cables

Connecting USB Cable

@ IMPORTANT

Make sure that the power to the machine is turned off.
% Power Off (page 2-9)

1 Connect the cable to the machine.

1 Connect the USB cable to the USB interface connector.

>0
Q

2 Connect the other end of the cable to the PC.

2 Power on the machine.

Connecting the Power Cable

1 Connect the cable to the machine.

Connect one end of the supplied power cable to the machine and the other end to a power
outlet.

@ IMPORTANT

Only use the power cable that comes with the machine.
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Installing and Setting up the Machine > Power On/Off

Power On/Off

Power On

1 Turn the power switch on.

Power Off

1 Turn the power switch off.

It takes about 3 minutes for power off.

A\ caution

If this machine will be left unused for an extended period (e.g. overnight), turn it off at the power switch. If the
machine will not be used for an even longer period of time (e.g. vacation), remove the power plug from the
outlet as a safety precaution.

(©) IMPORTANT
Remove paper from the cassettes and seal it in the paper storage bag to protect it from humidity.
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Installing and Setting up the Machine > Using the Operation Panel

Using the Operation Panel

Operation Panel Keys

N

0 N o o b~ W

9

12
1 11
2,3
4 10
5 ——— 0 JOIEUEE
6
7 9
8

[Menu] key: Displays the Menu screen.

Arrow keys: Increments or decrements numbers, or selects menu in the message display. When a specific error
occurs, select the [»] (8) key to show the Help screen.

[OK] key: Finalizes a function or menu, and numbers that have been entered.
[Go] key: Clears a specific error, and wakes the machine from the sleep state.
[Quiet Mode] key: Lower print speed for quiet processing.

[Wi-Fi] indicator ': Blinks during Wi-Fi connection.

[Energy Saver] indicator: Lights up when the machine is in energy save mode.

[Ready] indicator: Lights up in the print ready state.
Blinks during print processing or when an error occurs.

[Attention] indicator: Lights or blinks when an error occurs and a job is stopped.

10 [Cancel] key: Cancel a printing job.

11 [Logout] key: Exits the operation for the current user (i.e. log out).

12 Message display: Displays the setting menu and error messages.

*1  Only for models with Wi-Fi.

2-10



Installing and Setting up the Machine > Using the Operation Panel

Operation Method

Displaying the Menus and Configuring Settings

Select the [Menu] key to display the setting menus. Select the [A] key, [ V] key, [ 4] key, [»>] key, or [OK] key to select a
menu, and perform settings.

Select the [Menu] key to display
the setting menus.

MENU
Normal Screen

Setting Menus

Report Print

Report Print

When the [A] or [ V] key is selected,
the selection moves line by line.

Exiting the menu operation

Select the [Menu] key to exit the setting
@enu and return to the normal screen. /

When [>] appears, select the [»>]

key to display a sub-menu. When the [A] or [V] key is
selected, the selection

v moves line by line.

Paper Settings >MP Tray Size >Type Adjust Paper Wdigh
a4 cusTom_1 ( wormaii )

Select the [ 4] key to return to the Select the [OK] key to confirm
screen one level higher. the selected setting.



Installing and Setting up the Machine > Using the Operation Panel

Selecting a Menu

The setting menu is hierarchical. Select the [A] or [ V] key to display the desired menu.

* If the selected menu has a sub-menu, ">" is displayed after the menu. ‘ N
Paper Settings

Indicates that there is a sub-menu

« ">"|s displayed before the sub-menu. Indicates that this is the sub-menu
When there is a another sub-menu, ">" appears after the sub-menu name. ; 1 25
To move down a level to that sub-menu, select the [»] key. To move back up Fﬁype Adjust \>{
to the next higher level, select the [«] key. ChoToM 1 |

Indicates that there is another sub-menu

">>" is displayed before the second sub-menu. .
\>zPaper Weight

1 Normal 1
|

Indicates that this is the second sub-menu

Setting a Menu

Select the desired menu and then select the [OK] key. In the menu, select the desired item with the [A] or [ V] key, and
select the [OK] key. "?" will blink to the right of the selected item. Select the [OK] key to finalize the setting.

Cancelling Menu Selection

If you select the [Menu] key when a menu is selected, the message display returns to "Ready".

NOTE

Settings in an application or printer driver are given priority over operation panel settings.

Help Screen

If you have difficulty operating the machine, you can check how to operate it using the operation panel.

When "Press @ key" is displayed on the message display, select the [»>] (8) key to display the Help screen. The Help
screen shows machine operation.

--—-— HELP START ---- Open Cassette 1
Press i key Yand remove

Select the [ V] key to display the next step or select the [A] key to display the previous step.
Select the [»] (@) key to exit the Help screen.
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Installing and Setting up the Machine > Login/Logout

Login/Logout

If you are setting a function that requires administrator rights, you must enter your administrator ID and administrator
password.

NOTE

The factory default administrator ID and administrator password are both set as 2100.

Login

1 Enter the administrator ID.

If the administrator login screen appears while you a using the machine, enter the
administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»] key to move the cursor left or right.

2 Enter the administrator password.

Enter the administrator password and select [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.
Select the [ «] or [»>] key to move the cursor left or right.

3 Select the [OK] key.
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Installing and Setting up the Machine > Login/Logout

Logout

Select the [Logout] key to exit the setting menu screen and log out. You will return to the
normal screen.

Users are automatically logged out in the following circumstances:
*  When the machine enters the sleep state.

* When the auto panel reset function is activated.
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Installing and Setting up the Machine > Default Settings of the Machine

Default Settings of the Machine

Before using this machine, configure such settings as date and time, network configuration, and energy saving functions
as needed.

NOTE
The default settings of the machine can be changed in System Menu.
For settings that are configurable from System Menu, refer to the following:

= Setup and Reqistration (System Menu) (page 6-1)

Setting Date and Time

Follow the steps below to set the local date and time at the place of installation.
Set the date, time and time difference from GMT of the region where the machine is used.

NOTE

* The factory default administrator ID and administrator password are both set as 2100.
» Be sure to set the time difference before setting the date and time.

» The correct time can be periodically set by obtaining the time from the network time server.

% Command Center RX User Guide

1 Display the screen.

1 [Menu] key >[A][V] key > [Device Common] > [»>] key >[A][V] key > [Date Setting] >
[»] key

2 Enter the administrator ID and select the [OK] key.

NOTE
Enter an ID consisting of between 1 and 16 numbers.

Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.

3 Enter the administrator password and select the [OK] key.

NOTE
 Enter a password consisting of between 0 (no settings) and 16 numbers.

Select the [A] or [ V] key to enter a number.
Select the [ «] or [»>] key to move the cursor left or right.

+ If you enter the incorrect administrator ID or password, the message "Wrong ID" or
"Wrong Password" appears and the input screen then reappears. Re-enter the ID or
password correctly.
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Installing and Setting up the Machine > Default Settings of the Machine

2 Configure the settings.

[A][V]key > [Time Zone] > [OK] key > Select the time zone > [OK] key > [A] [ VY] key >
[Date (Year/Mon/Day)] > [OK] key > Set the date > [OK] key > [A] [ V] key >

[Time (Hour:Min:Sec)] > Set the time > [OK] key > [ A] [ V] key > [Date Format] > [OK] key >
Select the Date Format > [OK] key

Item Description

Time Zone Set the time difference from GMT. Choose the nearest listed location from
the list. If you select a region that utilizes summer time, configure settings
for summer time.

Date (Year/Mon/Day) Set the date for the location where you use the machine.
Value: Year (2000 to 2037), Month (1 to 12), Day (1 to 31)

Time (Hour:Min:Sec) Set the time for the location where you use the machine.
Value: Hour (00 to 23), Minute (00 to 59), Second (00 to 59)

Date Format Select the display format of year, month, and date. The year is displayed
in Western notation.

Value: Month/Day/Year, Day/Month/Year, Year/Month/Day
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Installing and Setting up the Machine > Network Setup

Network Setup

Configuring the Wired Network

The machine is equipped with network interface, which is compatible with network protocols such as TCP/IP (IPv4),
TCP/IP (IPv6), NetBEUI, and IPSec. It enables network printing on the Windows, Macintosh, UNIX and other platforms.

Set up TCP/IP (IPv4) to connect to the Windows network.

Be sure to connect the network cable before configuring the settings.

® Connecting LAN Cable (page 2-7)

For other network settings, refer to the following:

= Network Settings (page 6-13)

IPv4 setting

1 Display the screen.
[Menu] key > [A] [¥] key > [Wired Network] > [>] key > [A] [¥] key > [TCP/IP] > [OK] key

2 Configure the settings.
1 [A][V]key > [On] > [OK] key
Select [»] key while "TCP/IP On" is displayed.
[A][V]key > [DHCP] > [OK] key > [A] [ V] key > [Off] > [OK] key
[A][V]key > [IP Address] > [OK] key

a ~ @ DN

Set the IP address.

NOTE

You can set any value between 000 and 255.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.

6 Select the [OK] key.
7 [A][V]key > [Subnet Mask] > [OK] key

8 Set the subnet mask.

NOTE

You can set any value between 000 and 255.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.

9 Select the [OK] key.

10[A] [ V] key > [Default Gateway] > [OK] key
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Installing and Setting up the Machine > Network Setup

11 Set the default gateway.

NOTE

You can set any value between 000 and 255.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.

12Select the [OK] key.
13[A] [ V] key > [Auto-IP] > [OK] key
14[0ff] > [OK] key

@ IMPORTANT

After changing the setting, restart the network from System Menu, or turn the
machine OFF and then ON.

® Restart Printer (page 6-24)

NOTE

Ask your network administrator for the IP address in advance, and have it ready when you
configure this setting.
In the following cases, set the IP address of DNS server on the Command Center RX.

* When using the host name with "DHCP" setting set to "Off"
* When using the DNS server with IP address that is not assigned by DHCP automatically.
Setting the IP Address of the DNS Server, refer to the following:

# Command Center RX User Guide
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Installing and Setting up the Machine > Network Setup

Configuring the Wireless Network

When the wireless network function is available on the machine and the connection settings are configured, it is possible
to print in a wireless network (wireless LAN) environment. The configuration methods are as follows:

Configuration Method Description Reference Page

Configuring the Connection Use Wi-Fi Settings or Wireless Network to configure the Wi-Fi Settings (page 6-10)

from the Operation Panel on network in details from System menu.

This Machine

Setting the Connection by This is the tool included in the Product Library. You can Setting the Connection by Using
Using the Wi-Fi Setup Tool configure the connection according to the instructions the Wi-Fi Setup Tool (page 2-19)

provided by the wizard.

Configuring Connections on The connection can be set from the Command Center RX. | Command Center RX User
the Web Page Guide

NOTE
On a model with a Wi-Fi function, change the settings in "Communication" appropriately if you switch to other than a
wired network interface.

® Communication (page 6-13)

Setting the Connection by Using the Wi-Fi Setup Tool

To send the Wi-Fi settings configured in the Wi-Fi Setup Tool to the machine, connect the computer or handheld device
with the machine locally. The connection methods are wired connection via LAN cable and wireless LAN connection
(Wi-Fi Direct).

NOTE
» Before using the Wi-Fi Setup Tool, connect your computer to this machine locally with wired LAN cable or Wi-Fi
Direct.

» To use Wi-Fi Direct, confirm that the Wi-Fi Direct is enabled (Wi-Fi Direct is set to [On]) and Restart Network from
the operation panel, before your computer will be connected to this machine with Wi-Fi Direct.

» To use a wired LAN cable directly connected to the machine, the Auto-IP (Link-local) address will be assigned to the
machine and the computer. This machine applies Auto-IP as the default settings.

» Configure the settings on the operation panel if your computer supports WPS.
& Wi-Fi Settings (page 6-10)

Wired Connection by Using LAN Cable

1 Connect the machine with a computer
1 Connect the machine with a computer via LAN cable when the machine is powered on.

2 Turn on the computer.

IP address (link local address) of the machine and computer is generated automatically.
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Installing and Setting up the Machine > Network Setup

2 Launch the Wi-Fi Setup Tool.
1 Launch a web browser.

2 Enter "https://kyocera.info/" to the browser's address bar or location bar.

B <& [E New tab X 4+ v

é > O @ https://kyocera.info/ *

3 Enter and search the product name, and select this product from the candidate list.

St | @ e oy /g

@ KYOCERA

Download Center

4 Change the selected operating system and its language setting as needed.

GKYOCERG st s RO

Download Center

a [T ——
P

Download

s 8 8 88

Easy Installation
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Installing and Setting up the Machine > Network Setup

5 Utility tab > "Wi-Fi Setup Tool"
The Wi-Fi Setup Tool will be downloaded.

O KYOCER  #octsa tonen shers

Download Center

Easy Installation

6 Double-click the downloaded installer to launch.

NOTE

+ Installation on Windows must be done by a user logged on with administrator
privileges.
+ If the user account management window appears, click [Yes] ([Allow]).

7 Click [Search] in charms, and enter "Wi-Fi Setup Tool" in the search box. Select [Wi-Fi
Setup Tool] in the search list

NOTE

In Windows 8.1, click [Search] in charms, and enter "Wi-Fi Setup Tool" in the search box.
Select [Wi-Fi Setup Tool] in the search list

3 Configure the settings.
Follow the on-screen instructions that appear in the tool.

The network is configured.

Wireless LAN Connection by Using Wi-Fi Direct

1 Display the screen.
1 [Menu] key > [A][V] key > [Wi-Fi Direct Set] > [»] key
2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.

Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.

The factory default settings for the administrator ID is set as 2100.

3 Enter the administrator password and select the [OK] key.
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Installing and Setting up the Machine > Network Setup

NOTE

Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The factory default settings for the administrator password is set as 2100.

4 [A][V¥]key > [Wi-Fi Direct] > [OK] key

2 Configure the settings.
[A][V]key > [On] > [OK] key

3 Restart the network.

[Menu] key > [A] [ VY] key > [Wi-Fi Settings] > [»>] key > [A] [ Y] key > [Restart Network] >
[OK] key > [OK] key

4 Connect a computer or a handheld device with the machine.
® Setting Wi-Fi Direct (page 2-26)

5 Launch the Wi-Fi Setup Tool.
1 Launch a web browser.

2 Enter "https://kyocera.info/" to the browser's address bar or location bar.

B <& [E New tab X [

- O ) https://kyocera.info/ sk

3 Enter and search the product name, and select this product from the candidate list.

oY e R —

Download Center

........
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Installing and Setting up the Machine > Network Setup

4 Change the selected operating system and its language setting as needed.

TR KYOCERA  mocom b s

Download Center

nnnnnnnnnnnnn

Fin name Vorson Release dote

£ B B8 a8 8

Easy Installation

5 Utility tab > "Wi-Fi Setup Tool"
The Wi-Fi Setup Tool will be downloaded.

{7 R r——

Download Center

- ]
Download 1
Orver Uty M

a p. !

a [+ ] 2
a 1w !

a e - |

Snow o dver ~

Easy Installation

6 Double-click the downloaded installer to launch.

NOTE

* Installation on Windows must be done by a user logged on with administrator
privileges.
* If the user account management window appears, click [Yes] ([Allow]).

7 Click [Search] in charms, and enter "Wi-Fi Setup Tool" in the search box. Select [Wi-Fi
Setup Tool] in the search list

NOTE
In Windows 8.1, click [Search] in charms, and enter "Wi-Fi Setup Tool" in the search box.
Select [Wi-Fi Setup Tool] in the search list
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6

Configure the settings.
Follow the on-screen instructions that appear in the tool.

The network is configured.

Configuring Network Connection Using the Push Button

If your router supports WPS, you can configure network connection using the push button.

1

Configure the network between the computer and the router
(access point).

Turn on the printer.

[Menu] key > [A] [V] key > [Wi-Fi Settings] > [»>] key > [Wi-Fi] >
[OK] key > [A] [ Y] key > [On] > [OK] key

[A][V] key > [Quick Setup] > [»>] key > [OK] key > [A] [V] key >
[Push Button] > [OK] key

According to the message displayed, press the push button on
access point and then press [OK] key.

The network between the printer and the router is configured. If the network connection
between this machine and the router is complete, [Wi-Fi] indicator will light up.

Install the printer driver for wireless network connection on
your computer.

® [nstalling Software in Windows (page 2-34)

® Installing Software in Mac Computer (page 2-40)

Configuring Network Connection by Entering a PIN

You can configure the network by entering a PIN generated by the printer into the router (access point) page.

1

Configure the network between the computer and the router
(access point).

Turn on the printer.

[Menu] key > [A] [V] key > [Wi-Fi Settings] > [»>] key > [Wi-Fi] >
[OK] key > [A] [ VY] key > [On] > [OK] key

[A][V] key > [Quick Setup] > [»>] key > [OK] key > [A] [V] key >
[PIN(Device)] > [OK] key

Confirm the PIN on the message display and write down it.
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5 Access the setup screen of the router and enter the PIN
written down in step 4.

The network between the printer and the router is configured. If the network connection
between this machine and the router is complete, [Wi-Fi] indicator will light up.

6 Install the printer driver for wireless network connection on
your computer.

® Installing Software in Windows (page 2-34)

® Installing Software in Mac Computer (page 2-40)
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Setting Wi-Fi Direct

When the wireless network function is available on the machine, setting Wi-Fi Direct enables you to print from the Wi-Fi
Direct environment. The configuration methods are as follows:

Configuring the Connection from the Operation Panel on This Machine

Connecting to Computers or Handheld Devices that Support Wi-Fi Direct

1 Display the screen.
1 [Menu] key > [A] [ V] key > [Wi-Fi Direct Set] > [»>] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.

Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.

The factory default settings for the administrator ID is set as 2100.

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.

The factory default settings for the administrator password is set as 2100.

4 [A][V¥]key > [Wi-Fi Direct] > [OK] key

2 Configure the settings.
[A][V]key >[On] > [OK] key

3 Restart the network.

[Menu] key > [A] [VY] key > [Wi-Fi Settings] > [»>] key > [A] [ V] key > [Restart Network] >
[OK] key > [OK] key

4 Specify the machine name from the computer or handheld
device.

If a confirmation message appears on the operation panel of the machine, select [Yes].

The network between this machine and the handheld device is configured.

Connecting to Computers or Handheld Devices Unsupported Wi-Fi Direct

Here, we'll explain the procedures for connecting to iOS handheld devices.

1 Display the screen.
1 [Menu] key > [A][V¥] key > [Wi-Fi Direct Set] > [>] key

2 Enter the administrator ID and select the [OK] key.
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NOTE

Enter an ID consisting of between 1 and 16 numbers.

Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The factory default settings for the administrator ID is set as 2100

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.

The factory default settings for the administrator password is set as 2100.

4 [A][V¥]key > [Wi-Fi Direct] > [OK] key

2 Configure the settings.
[A][V]key >[On] > [OK] key

3 Restart the network.
[Menu] key > [A] [ V] key > [Wi-Fi Settings] > [»>] key > [A] [ V] key > [Restart Network] >
[OK] key > [OK] key

A [Menu] key > [A] [V] key > [Wi-Fi Direct Set] > [>] key

Note the network name (SSID), IP address, and password.

)]

& Configure the handheld device.
1 [Settings] > [Wi-Fi]
2 Select the network name (SSID) appeared in step 5 from the list.

3 Enter the password that was provided in step 5 > [Connect]

The network between this machine and the handheld device is configured.

Configuring the Connection by Using Push Button

When your computer or handheld device does not support Wi-Fi Direct but supports WPS, you can configure the
network using push button.

1 Display the screen.
1 [Menu] key > [A][V] key > [Wi-Fi Direct Set] > [»] key
2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.

Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.

The factory default settings for the administrator ID is set as 2100.

2-27



Installing and Setting up the Machine > Network Setup

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The factory default settings for the administrator password is set as 2100.

4 [A][V¥]key > [Wi-Fi Direct] > [OK] key

2 Configure the settings.
[A][V]key >[On] > [OK] key

3 Restart the network.

[Menu] key > [A] [ V] key > [Wi-Fi Settings] > [»>] key > [A] [ Y] key > [Restart Network] >
[OK] key > [OK] key

4 [Menu] key >[A][V] key > [Wi-Fi Direct] > [>] key > [A] [V] key
> [PushButton Setup] > [OK] key > [OK] key

5 Press the push button on the computer or handheld device and
select the [OK] key simultaneously.

The network between this machine and the computer or handheld device is configured.

@ IMPORTANT

You can connect up to three handheld devices at the same time using Wi-Fi Direct setting. When the devices
that support Wi-Fi Direct are connected, if you want to connect other device, disconnect the
already-connected devices from the network. The disconnection methods are as follows:

» Disconnect the network from the computer or handheld computer
« Disconnecting all devices from the network on the operation panel
Select [Menu] key > [A] [ V] key > [Wi-Fi Direct] > [»>] key > [A] [ V] key > [Disconnect All] > [OK] key >
[OK] key
» Configuring auto disconnecting time from the System menu
® Wi-Fi Direct Set (page 6-10)
» Configuring auto disconnecting time from the Command Center RX
® Command Center RX User Guide
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Energy Saver function

If a certain period of time elapses after the machine is last used, the machine automatically enters sleep mode, which
minimizes power consumption. If the machine is not used while in sleep mode, the power automatically turns off.

Auto Sleep

Auto Sleep automatically switches the machine into Sleep if left idle for a preset time.

The amount of time before entering Sleep is as follows.

* 1 minute (default setting)

If print data is received during Sleep, the machine automatically wakes up and starts printing.
To resume, perform the following actions.

» Select the [Go] key.

Recovery time from Sleep Mode is 12 seconds.

Note that ambient environmental conditions, such as ventilation, may cause the machine to respond more slowly.

1 Display the screen.
1 [Menu] key >[A][V¥] key > [Device Common] > [»] key > [A] [V] key > [Timer] > [»>] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.

Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The factory default settings for the administrator ID is set as 2100.

3 Enter the administrator password and select the [OK] key.
NOTE
Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.

The factory default settings for the administrator password is set as 2100.

4 [A][V]key > [Sleep Timer] > [OK] key
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2 Set the Sleep time.

1 Enter the Sleep time.

NOTE

You can set any value from 1 to 60 minutes.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»] key to move the cursor left or right.

2 Select the [OK] key.

Sleep Level Set.

Network, Card Reader

You can set whether sleep mode operates for each function. When the machine enters sleep mode, the ID card cannot
be recognized.

For more information on Sleep Level Set., refer to the following:

® Sleep Level Set. (page 6-20)

Sleep Level (models except for Europe)

For sleep level, you can toggle between the following two modes: Energy Saver mode and Quick Recovery mode. The
default setting is Energy Saver mode.

Energy Saver mode reduces power consumption even more than Quick Recovery mode, and allows Sleep Mode to be
set separately for each function. The ID card cannot be recognized.

To resume, select the [Go] key on the operation panel. If print data is received during Sleep, the machine automatically
wakes up and starts printing.

1 Display the screen.

1 [Menu] key > [A][V¥] key > [Device Common] > [»>] key > [A] [V] key >
[Sleep Level Set.] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.

Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.

The factory default settings for the administrator ID is set as 2100.

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The factory default settings for the administrator password is set as 2100.

4 [A][V]key > [Sleep Level] > [OK] key
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2 Select the Sleep level.
[A][V] key > [Quick Recovery] or [Energy Saver] > [OK] key

When [Energy Saver] is set, next go on to set whether or not to use Energy Saver mode for
each function.

3 Set the Sleep rule.
1 [A][V]key > [Network] or [Card Reader] > [OK] key

[Card Reader] is displayed when the optional Card Authentication Kit is activated.

2 [A][V]key > [Off] or [On] > [OK] key

Power Off Rule (models for Europe)

The Power Off Rule is used to stop the power from automatically turning off.
The default preset time is 3 days.

For more information on Power Off Rule settings, refer to the following:

®» Power Off Rule (models for Europe) (page 6-20)
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Quiet Mode

Lower print speed for quiet processing. Select this mode when the running noise is uncomfortable.
When the [Quiet Mode] key is selected, the [Quiet Mode] key blinks and Quiet Mode is enabled.

[Quiet Mode] key

NOTE

The processing speed will be slower than normal when in Quiet Mode.
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Installing Software

To use printer function, TWAIN/WIA connection, or network fax function, download and install prerequisite softwares
from our website (https://kyocera.info/).

Software on DVD (Windows)

o Expr
Software Description press
Install
KX DRIVER This driver enables files on a computer to be printed by the machine. O
Multiple page description languages (PCL XL, KPDL, etc.) are supported by
a single driver. This printer driver allows you to take full advantage of the
features of the machine.
Use this driver to create PDF files.
KPDL mini-driver/PCL This is a Microsoft MiniDriver that supports PCL and KPDL. There are some -
mini-driver restrictions on the machine features and option features that can be used
with this driver.
KYOCERA Net Viewer This is a utility that enables monitoring of the machine on the network. -
Status Monitor This is a utility that monitors the printer status and provides an ongoing O
reporting function.
KYOCERA Net Direct Print This makes it possible to print a PDF file without starting Adobe Acrobat/ -
Reader.
FONTS These are display fonts that enable the machine's built-in fonts to be used in O
a software application.

NOTE

Installation on Windows must be done by a user logged on with administrator privileges.
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Installing Software in Windows

Downloading and installing from the website

Download and install a software from our website.

1 Download a software from the website.

1 Launch a web browser.

2 Enter "https://kyocera.info/" to the browser's address bar or location bar.

B <& [E New tab X NSNS

é - O ' https://kyocera.info/ ‘f{

3 Enter and search the product name, and select this product from the candidate list.

TR KYOCERT  ocer swavmentsosions bl | @ Pt e Cary / Rogen

Download Center

4 Change the selected operating system and its language setting as needed.

(QKUDCERD recstnvmmes e R

Download Center

= Pt
it ik ]

Download

g o & & &8

Easy Installation
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5 Driver tab or Utility tab > of the software you want to download

An installer of the selected software will be downloaded.

O KYOCER  #octsa tonen shers

Download Center

= e
Vim0t
.

Download 1

e & & o

Easy Installation

2 Double-click the downloaded installer to launch.

Follow the guidance on the screen to install the software.

NOTE
« Installation on Windows must be done by a user logged on with administrator privileges.
* If the user account management window appears, click [Yes] ([Allow]).

Using the web installer

Install a software by using a web installer downloaded from our website.

1 Download a software from the website.
1 Launch a web browser.

2 Enter "https://kyocera.info/" to the browser's address bar or location bar.

B & [E New tab X BN

& > O o https://kyocera.info/ ﬁ

3 Enter and search the product name, and select this product from the candidate list.

WIKYOCERA weommsamensoinons o | @ Pt o Gy / e e

Download Center
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4 Change the selected operating system and its language setting as needed.

RKYOCERG rormsrn s B [ S

Download Center

a i —
[

Download

amas
EEEE

Easy Installation

5 Utility tab > "Web installer" &2
A web installer will be downloaded.

{7 =i = R ——

Download Center

wwwwwwwwww

< |

4 Select @ Operating System
Microsoft Windows 10 (64-5it)

Seiect 2 05 Languoge

< |

Englsh.

2 Double-click the downloaded installer to launch.

NOTE

* Installation on Windows must be done by a user logged on with administrator privileges.
* If the user account management window appears, click [Yes] ([Allow]).
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3 Display the screen.

@ cvocA e nsalr - x 1 Read the license agreement.
2 Click [Accept] if there is no
LICENSE AGREEMENT problem .
PLEASE READ THIS LICENSE AGREEMENT CAREFULLY BEFORE USING OR INSTALLING

THE SOFTWARE. BY USING OR INSTALLING THE SOFTWARE, YOU AGREE TO BECOME
BOUND BY THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT. IF YOU DO NOT
AGREE TO THESE TERMS AND CONDITIONS, DO NOT INSTALL OR USE THE SOFTWARE

LICENSE AGREEMENT

License. KYOCERA Document Solutions Inc. (‘KYOCERA”) grants you a non-exclusive, non-
transferable license to use the Software and related materials included in this package (all referred to
herein as the "Software”). “Use” means storing, loading, installing, executing or displaying the
Software

You may not:

a) modify, translate, reverse engineer, decompile, disassemble, create derivative
works based on, or copy (except for the backup copy) the Software;

b) rent, transfer or grant any rights in the Software in any form to any person
without the prior written consent of KYOCERA;

c) remove any proprietary notices, labels or marks on the Software;

d) Post the Software to anv location that is electronicallv accessible to the aeneral

4 Click [Install].

R Web Installer - X

Web Installer

4 T
= -4 A
S
Install Uninstall Malitenance
nstollprnter drivers Romove devicss, ‘
and ufility applications. drivers, and utilities Bun ufilty programs

©2020 KYOCERA Document Solutions inc.

5 Select a model and click [Next].

3 Web Installer - 5

Available devices

C Didn't find your device? Click here to search again.

© 2020 KYOCERA Document Solutions Inc.

NOTE
» The machine cannot be detected unless it is on. If the computer fails to detect the
machine, verify that it is connected to the computer via a network or USB cable.

* If a desired device is not displayed, select [Add custom device] to directly select the
device you want to use.
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6 Install the softwares.

1 Select softwares you want to install.

NOTE

Softwares recommended to install have [ in their checkboxes by default. Configure
them as needed.

(B Web Installer - X

Select components fo install 717

—
TS

€ Bock Package [ml 2

© 2020 KYOCERA Ine

2 Click [Install].

When [Install] is clicked, a screen which asks for cooperation for data collection may
appear. Select one of the answer choices and click [OK].

NOTE
+ If the Windows security window appears, click [Install this driver software anyway].

* To install Status Monitor for Windows 8.1, it is necessary to install Microsoft. NET
Framework 4.0 beforehand.

® s s -

Setup has detected that the following prerequisites have not
been met.

@ Microsoft .NET Framework 4.0

www.microsoft.com

7 Finish the installation.

[ Web Installer - X (& Web Installer - X

Installation progress Configure your printer

Ep £ a (comt;

(comt) Installed
020 KYOCERA Document Solutions Inc. - © 2020 KYOCERA Document Solutions Inc. -

Click [Next] > [Finish] to finish the installation wizard.

(comr) Installed

If a system restart message appears, restart the computer by following the screen prompts.
This completes the printer driver installation procedure.
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Uninstalling the Software

Perform the following procedure to delete the Software from your computer.

NOTE

Uninstallation on Windows must be done by a user logged on with administrator privileges.

1 Display the screen.

Click Search box in taskbar, and enter "Uninstall Kyocera Product Library" in the search box.
Select [Uninstall Kyocera Product Library] in the search list.

NOTE

In Windows 8.1, click [Search] in charms, and enter "Uninstall Kyocera Product Library" in
the search box. Select [Uninstall Kyocera Product Library] in the search list.

2 Uninstall the software.

Place a check in the check box of the software to be deleted.

<
©} KYOCERE

Welcome 1o the Software Remove Wizard
| Please close al your appications before cortinuing

(@  This wizard helps you remove software for your printing system.

V| Select Al
El0

R
=\

(= e

3 Finish uninstalling.

If a system restart message appears, restart the computer by following the screen prompts
This completes the software uninstallation procedure.

NOTE

» The software can also be uninstalled using the Product Library.

* In the Product Library screen, click [Uninstall], and follow the on-screen instructions to
uninstall the software.
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Installing Software in Mac Computer

The machine's printer functionality can be used by a Mac computer.

NOTE

* Installation on Mac OS must be done by a user logged on with administrator privileges.

* When printing from a Macintosh computer, set the machine's emulation to [KPDL] or [KPDL(Auto)].

® Emulation (page 6-8)

* If connecting by Bonjour, enable Bonjour in the machine's network settings.

® Bonjour (page 6-13)

« In the Authenticate screen, enter the name and password used to log in to the operating system.

» When printing via AirPrint, you do not have to install the software.

1

Download a software from the website.

1 Launch a web browser.

2 Enter "https://kyocera.info/" to the browser's address bar or location bar.

B
<

3 Enter and search the product name, and select this product from the candidate list.

< [= New tab

O @

GIKYOCERD e s

X 4+ w

https://kyocera.info/

S| @ s oy g

Download Center

Placse select your

uuuuuuuuuuuuu
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4 Change the selected operating system and its language setting as needed.

CKYOCERD  #ocom s s Ghod || @t oy

Download Center

o el i

ﬂ = e
W 5218

Download

Driver Utiity Manul

Fil nama

a a8 a

a

Showal crvec v

Easy Installation

5 Driver tab or Utility tab > of the software you want to download

An installer of the selected software will be downloaded.

oL T —— s | @ coen

Download Center

e
s~
Moc 05 105 and ater
i Select a OS Languoge
engion
—
Download 1
oner I
-
— ——
u = <]
g wm ommw FO—— = :Z
St v

2 Install the Printer Driver.

6006 -
{g KHDEERE Welcome to the Kyocera Macintosh Installer
@ Introduction
® Read M, You will be guided through the steps necessary to
install this software.
.
. .
o ¥
o
os

<

Install the printer driver as directed by the instructions in the installation software.
This completes the printer driver installation.

If a USB connection is used, the machine is automatically recognized and connected.
If an IP connection is used, the settings below are required.
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3 Configure the printer.

1 Open System Preferences and add the printer.

06 n e6en

e [ — o a

printer

e g o @ @8 - —

Screen Saver Control  &Region & Privacy Open Print Queue... |

= L
it

Options & Supplies... |

7o s

E @ 8 o | Share this printer on the network | Sharing Preferences.
(Cloud  Internet  Network  Bluetooth Sharing
Accounts <[

(G

3

©

. _ Default printer: | Last Printer Used 3]
i 8 4y 2| e —
X 4 r \Jie —_— Defaultpapersize: (A& 3| (37)
Users&  Parental  AppStore  Dictation Date&Time  Startup Time  Accessibility
Groups  Controls & Speach Dis) Machine
= -~

2 Select [Default] and click the item that appears in "Name" and then select the driver in

NOTE

When using an IP connection, click the IP icon for an IP connection and then enter the
host name or IP address. The number entered in "Address" will automatically appear in
"Name". Change if needed.

3 Select the options available for the machine.

e
Bt —
Defauk| F 1P Windows Search
1 Setting up. .

!

!

L]

canc 2

[ Add

4 The selected machine is added.

eeon
[«i>|[ showan | Q
) —— — ——
T

. — —
- - Open Print Queue... |
e, Last Used =

Options & Supplies... |

| Share this printer on the network | Sharing Preferences

Default printer: | Last Printer Used D)

Default paper size: | A4 ] @
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Checking the Counter

Check the number of sheets printed.

1 Display the screen.
[Menu] key > [A] [¥] key > [Counter] > [»] key

2 Check the counter.

Select the item you want to check.
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Additional Preparations for the Administrator

In addition to the information provided in this chapter, the administrator of this machine should check the following, and
configure the settings as needed.

Strengthening the Security

One user with administrator rights has been pre-registered in the machine. Logging in as this user will allow you to
configure all settings; therefore, please change the login user name and password.

In addition, this machine is equipped with user authentication function, which can be configured to limit the access to this
machine to only those who have a registered login name and password.

® User Authentication and Accounting (User Login. Job Accounting) (page 7-1)

| want to... Function Reference page
Restrict the users of the machine. Auto Panel Reset page 6-19
Protect the transmission from interception and | IPP over SSL page 6-14
wiretapping.
HTTPS page 6-15
SMTP Security Command Center
RX User Guide
POP3 Security Command Center
RX User Guide
IPSec page 6-13
SNMPv3 page 6-13
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Command Center RX

If the machine is connected to the network, you can configure various settings using Command Center RX.

This section explains how to access Command Center RX, and how to change security settings and the host name.

% Command Center RX User Guide

NOTE

To fully access the features of the Command Center RX pages, enter the User Name and Password and click [Login].
Entering the predefined administrator password allows the user to access all pages, including Document Box. The
factory default setting for the default user with administrator privileges is shown below. (Upper case and lower case
letters are distinguished (case sensitive).)

Login User Name: Admin
Login Password: Admin

Settings that the administrator and general users can configure in Command Center RX are as follows.

Administ- General

Setting Description ator Usar
Device The machine's structure can be checked. O O
Information
Job Status Displays all device information, including print jobs, and job log history. O O
Document Box Configures settings related to the Job Box. O -
Device Settings Configure the advanced settings of the machine. O -
Function Settings | Configure the advanced function settings. O -
Network Settings | Configure the network advanced settings. O -
Security Settings | Configure the security advanced settings. O -
Management Configure the advanced management settings. O -
Settings
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Accessing Command Center RX

1 Display the screen.
1 Launch your Web browser.

2 In the address or location bar, enter the machine's |IP address or the host name.
Print the status page to check the machine's IP address and the host name.

[Menu] key > [A] [ V] key > [Report Print] > [»>] key > [A] [ V] key > [Print Status Page] >
[OK] key > [OK] key

Examples: https://192.168.48.21/ (for IP address)
https://MFP001 (if the host name is "MFP001")

[ @ https:/192.168.48.21 x |+ - o X

s://192.168.48.21

KYOCERG e
Command Center X . 0"

Location
—— Last Updated -
[Engish  v| | [ |Auto-efiesh 2021/11104 06:35:01 @

0 User Name Device Status
W

Password % Printer Sleeping..

Admin Login

Q Status Message @) Sleeping

£z

g S i i C i Stat
?;'»iJob Status ource apacity atus

Cassette 1 | 1 Plain 250 ]ﬁl Paper Loaded

The web page displays basic information about the machine and Command Center RX as well
as their current status.

NOTE

If the screen "There is a problem with this website's security certificate.” is displayed,
configure the certificate.

% Command Center RX User Guide

You can also continue the operation without configuring the certificate.

2 Configure the function.

Select a category from the navigation bar on the left of the screen.

NOTE

To fully access the features of the Command Center RX pages, enter the User Name and
Password and click [Login]. Entering the predefined administrator password allows the user
to access all pages, including Document Box. The factory default setting for the default user
with administrator privileges is shown below. (Upper case and lower case letters are
distinguished (case sensitive).)

Login User Name: Admin
Login Password: Admin
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Changing Security Settings

1

Display the screen.

1
2

Launch your Web browser.

In the address or location bar, enter the machine's IP address or the host name.
Print the status page to check the machine's IP address and the host name.

[Menu] key > [A] [ VY] key > [Report Print] > [>] key > [A] [ V] key > [Print Status Page] >
[OK] key > [OK] key

Log in with administrator privileges.

Admin Login
6‘ User Name Device
= [Admin
Password %

e | &

The factory default setting for the default user with administrator privileges is shown below. (Upper
case and lower case letters are distinguished (case sensitive).)

Login User Name:  Admin
Login Password: Admin

Click [Security Settings].
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2 Configure the Security Settings.
From the [Security Settings] menu, select the setting you want to configure.

KYOCERD Model
Host Name :

Command Center B [ . .
O5)Ss* |

@ i Security Settings : Device Security 12'831#1';1’7; ;egé_%. 45 @

Interface Block

Network : Refer to this link. Protocol
Device Information >
USB Device : (O Block (@ Unblock
3 Job Status > USB Host : (O Block @ Unblock
@Document Box > USB Drive : () Block @ Unblock
L=
%Device Coanr > Lock Operation Panel
Operation Panel | Unlock v
QFuncﬁon Settings >
Display Status/Log
gNetwork Settings >
Display Jobs Detail Status : [ Show All v|
'ﬁ ‘Security Settings Display Jobs Log : [ Show All v|
Dstuors Securis Reserve a Sanitization Time (OOn @ Off

NOTE

For details on settings related to certificates, refer to the following:

% Command Center RX User Guide
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Changing Device Information

1 Display the screen.
1 Launch your Web browser.

2 In the address or location bar, enter the machine's IP address or the host name.
Print the status page to check the machine's IP address and the host name.
[Menu] key > [A] [ VY] key > [Report Print] > [>] key > [A] [ V] key > [Print Status Page] >
[OK] key > [OK] key

3 Log in with administrator privileges.

Admin Login

0 User Name Device
Admin

Admin |
Password %

e | &

The factory default setting for the default user with administrator privileges is shown below. (Upper
case and lower case letters are distinguished (case sensitive).)

Login User Name:  Admin
Login Password: Admin

4 From the [Device Settings] menu, click [System].

KYOCERD Model
Host Name

Command Center B [ 70

Last Updated:
2021/11/04 06:55:47

Device Information

Host Name : [KMBD6C33
Device Information > Asset Niwbia ‘
&4 Location : \
55 Job Status >
General
f—.’%y Document Box
e Language : [ English
RAM Disk Mode : @®@0On
Paper/Feed/Output RAM Disk Size : 32 |MB (1-32)
Energy Saver/Timer Override Ad/Letter : @0On oo
2‘ Date/Time |
m— Altitude Adjustment : Normal v
Device Managed by Administrator : O Yes @ No
q Function Settings >
Error Settings
@Network Settings > Color Toner Empty Action : ~) Stop Printing @ Printin B&W
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2 Specify the host name.

Enter the device information, and then click [Submit].

(©) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

To restart the network, click [Reset] in the [Management Settings] menu, and then
click [Restart Network] in "Restart".
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E-mail Settings

By configuring the SMTP settings, it is possible to send E-mail notices when jobs have been completed.

To use this function, this machine must be connected to a mail server using the SMTP protocol.

In addition, configure the following.

* SMTP settings

Iltem: "SMTP Protocol" and "SMTP Server Name" in "SMTP"

¢ The sender address when the machine sends E-mails
Item: "Sender Address" in "E-mail Send Settings"

* The setting to limit the size of E-mails
Item: "E-mail Size Limit" in "E-mail Send Settings"

The procedure for specifying the SMTP settings is explained below.

1

Display the screen.

Display the SMTP Protocol screen.

1
2

Launch your Web browser.

In the address or location bar, enter the machine's IP address or the host name.
Print the status page to check the machine's IP address and the host name.

[Menu] key > [A] [ VY] key > [Report Print] > [>] key > [A] [V] key > [Print Status Page] >
[OK] key > [OK] key

Log in with administrator privileges.

Admin Login

0‘ User Name Device
/Admin
Password %

e &

The factory default setting for the default user with administrator privileges is shown below. (Upper
case and lower case letters are distinguished (case sensitive).)

Login User Name:  Admin
Login Password: Admin
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4 From the [Network Settings] menu, click [Protocol].

Print Protocols
NetBEUI : Ooff
5 Devi : o _—
Device Information > Avallable Network: /] Wfrefl Network & Wi-Fi
Wi-Fi Direct
%Job Status > Workgroup | KM-NetPrinters |
Comment : | |
LPD @On O off
& Wi v i
Available Network : @ W,'ref, Network e
Wi-Fi Direct
FTP Server (Reception) : @On O off
v v i
Available Network : @ Mred Network GwiFi
Wi-Fi Direct
IPP @On O off
2 Wi v i
Available Network - 2 Wired Network B wiFi
Wi-Fi Direct
Port Number : |631 (1-32767)
IPP over SSL @®0On oo
2 Configure the settings.
Set "SMTP (E-mail TX)" to [On] in the "Send Protocols".
Send Protocols =
SMTP (E-mail TX) : OOn @ off

For more settings, click here. E-mail Settings

Other Protocols

SNMPv1iv2c :

Available Network :

SNMPv3 :

HTTP:

Available Network :
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For more settings, click here. SNMP Sattings

Wired Network Wi-Fi

Wi-Fi Direct
Thr; setting is used commoniy with SNMPv1/v2¢ and
SNMPV3,

OOn @ Off

For more settings. click here. SNMP Settings

To use these settings, enable Availale Network in

SNMPv1iv2e.

@On O off
Wired Network Wi-Fi
Wi-Fi Direct
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3 Display the screen.
Display the E-mail Settings screen.

From the [Function Settings] menu, click [E-mail].

Logout |

SMTP
SMTP Protocol Off
Device Information >
Settings must be made in SMTP (E-mail TX).
Protocol
=
g})é‘bb gt > SMTP Server Name ‘
o spacify the sarver name by domain name, sat DNS
server. TCP,
SMTP Port Number - [25 |(1-65535)
SMTP Server Timeout : [10  |seconds
l Authentication Protocol of v

Common/Job Default Make settings here. Protocol

fiiter Connection Test : I Test
Domain Restriction : Off v

@Network Settings > \ Domain List

4 Configure the settings.
Enter "SMTP" and "E-mail Send Settings" items.

Setting Description

SMTP Set to send e-mail from the machine.

SMTP Protocol Displays the SMTP protocol settings. Check that "SMTP
Protocol" is set to [On]. If [Off] is set, click [Protocol] and set
the SMTP protocol to [On].

SMTP Server Name™! Enter the host name or IP address of the SMTP server.

SMTP Port Number Specify the port number to be used for SMTP. The default port
number is 25.

SMTP Server Timeout | Set the amount of time to wait before time-out in seconds.

Authentication To use SMTP authentication, enter the user information for
Protocol authentication.
SMTP Security Set SMTP security.

Turn on "SMTP Security" in "SMTP (E-mail TX)" on the
[Protocol Settings] page.

Connection Test Tests to confirm that the E-mail function is operating under the
settings without sending a mail.

Domain Restriction To restrict the domains, click the [Domain List] and enter the
domain names of addresses to be allowed or rejected.
Restriction can also be specified by e-mail address.
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Setting Description

POP3 POP3 Protocol You don't need to set the following items when you only
enable the function of sending e-mail from the machine. Set
Check Interval the following items if you want to enable the function of

receiving e-mail on the machine.

=% Command Center RX User Guide

Run once now

Domain Restriction

POP3 User Settings

E-mail E-mail Size Limit Enter the maximum size of E-mail that can be sent in
Send kilobytes. When E-mail size is greater than this value, an error
Settings message appears and E-mail sending is cancelled. Use this

setting if you have set E-mail Size Limit for SMTP server. If
not, enter a value of 0 (zero) to enable E-mail sending
regardless of the size limit.

Sender Address™ Specify the sender address for when the machine sends
E-mails, such as the machine administrator, so that a reply or
non-delivery report will go to a person rather than to the
machine. The sender address must be entered correctly for
SMTP authentication. The maximum length of the sender
address is 128 characters.

Signature Enter the signature. The signature is free form text that will
appear at the end of the E-mail body. It is often used for
further identification of the machine. The maximum length of
the signature is 512 characters.

Function Defaults Change the function default settings in [Common/Job
Default Settings] page.

*1 Be sure to enter the items.

5 Click [Submit].
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3 Preparation before Use

This chapter explains the following operations.

[ 7= o 1 T N =T o= TSP UPPRPPPPRN: 3-2
[ (=Tor= TUN (o] g o] gl I =T [T To Tl =T oY OSSO 3-2
Selecting the Paper Feeder UNILS ...........oooiiiieiiieie et e e e e eme e e e seee e eneeeeeneaeenneeaes 3-3
18 7= o [1g Lo [T B LT =Tt (= NS — 3-4
Loading in the Cassette 2 ...ttt et e e e e e e s ee e ene e e e enae e eanneeans 3-7

Precautions for OUIPULING PAPET ........oo ittt et e e ee e e e e e e e emte e e e s eeemnne e e s eneeemneeeenneas 3-9
=TT ] (o] o] o= SR 3-9
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Loading Paper

Load paper in the cassettes.

Precaution for Loading Paper

When you open a new package of paper, fan the sheets to separate them slightly prior to loading in the following steps.

Fan the paper, then tap it on a level surface.
In addition, note the following points.

» If the paper is curled or folded, straighten it before loading. Paper that is curled or folded
may cause a jam.

* Avoid exposing opened paper to high humidity as dampness can be a cause of problems.
Seal any remaining paper after loading in the multipurpose tray or cassettes back in the
paper storage bag.

+ If the machine will not be used for a prolonged period, protect all paper from humidity by
removing it from the cassettes and sealing it in the paper storage bag.

@ IMPORTANT

If you print onto used paper (paper already used for printing), do not use paper that is
stapled or clipped together. This may damage the machine or cause poor image
quality.

NOTE

If you use special paper such as letterhead, paper with holes or paper with pre-prints like
logo or company name, refer to the following:

= Paper (page 9-8)
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Selecting the Paper Feeder Units

Select the paper feeder units according to the size and type of paper.

Paper Size Paper Type Capacity
1 Cassette 1 | A4, B5, A5-R, A5, A6, B6, Legal, Plain, Preprinted, Bond, Recycled, 250 sheets page 3-4
Oficio Il, Letter, Executive, Rough, Letterhead, Color, (80 g/m2)
2 Cassette 2 Statement-R, Folio, 16K, Prepunched, Thick, High Quality, page 3-7
216x340mm, B5(ISO), Custom Custom 1to 8

NOTE

* The number of sheets that can be held varies depending on your environment and paper type.

* You should not use inkjet printer paper or any paper with a special surface coating. (Such paper may cause paper
jams or other faults.)

* For higher quality color printing, use special color paper.
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Loading in the Cassette 1

1 Pull the Cassette 1 completely out of the machine.

NOTE

In some regions the cassette comes with a cover. If the cassette has a cover, open the
cover to adjust the guide.
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Adjust the position of the paper width guides located on the left
and right sides of the Cassette 1.

NOTE

If the cassette has a cover, close the cover.

@ IMPORTANT
e Load the paper with the print side facing up.

< After removing new paper from its packaging, fan the paper before loading it in the
multipurpose tray.

® Precaution for Loading Paper (page 3-2)

» Before loading the paper, be sure that it is not curled or folded. Paper that is curled
or folded may cause paper jams.

* Ensure that the loaded paper does not exceed the level indicator (see illustration
above).

« If paper is loaded without adjusting the paper length guide and paper width guide,
the paper may skew or become jammed.
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= Gently push the Cassette 1 back in.

j

NOTE

When Folio, Oficio Il, or Legal is used, the cassette will extend out from the machine.

6 Display the screen.

[Menu] key > [A] [V] key > [Paper Settings] > [»>] key > [A] [ V] key > [Cassette1 Size] >
[>] key

7 Configure the function.

Select the paper size and paper type.

® Paper Settings (page 6-6)
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Loading in the Cassette 2

1 Pull the Cassette 2 completely out of the machine.

Adjust the position of the paper width guides located on the left
and right sides of the Cassette 2.
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4 Load paper.

(©) IMPORTANT
« Load the paper with the print side facing up.

« After removing new paper from its packaging, fan the paper before loading it in the
multipurpose tray.

® Precaution for | oading Paper (page 3-2)

» Before loading the paper, be sure that it is not curled or folded. Paper that is curled
or folded may cause paper jams.

* Ensure that the loaded paper does not exceed the level indicator (see illustration
above).

« If paper is loaded without adjusting the paper length guide and paper width guide,
the paper may skew or become jammed.

5 Gently push the Cassette 2 back in.

6 Display the screen.

[Menu] key > [A] [V] key > [Paper Settings] > [»] key > [A] [ V] key > [Cassette2 Size] >
[>] key

7 Configure the function.
Select the paper size and paper type.

® Paper Settings (page 6-6)

3-8



Preparation before Use > Precautions for Outputting Paper

Precautions for Outputting Paper

Paper Stopper

When using paper B5/letter or larger, open the paper stopper shown in the figure.

SN
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4 Printing from PC

This chapter explains the following topics:

Printer DriVEr PrOPErtIES SCIEEN .......coiiiiiiiiee e ee ettt e e et e e e et ae e e e et s e e e e esaeeeeensseeseannsaeeeeenssaeeeannnns 4-2
Displaying the Printer DIIVEr HEIP ......cooo ettt e e 4-3
Changing the Default Printer Driver Settings (WINAOWS 10) .......oiiiiiioiiiie e 4-3

PHANLNG IO PG oo snsmussmommsssssmmssssmonsossmsssmomsss s 55 50 s o i S s s s S a0 o Fa o S A e e 4-4
Printing on Standard SIiZ€d PAPET ........ccueiiiiiiiiiie ettt e et e e e e e e s eraeeae e e eraaeaeeea e 4-4
Printing on Non-standard Sized PAper .............ooiiiiiioiiie e se e ee e e e e eaneeeeeeens 4-6
Canceling Printing from @ COMPULET ...t e e e e e e e e e ee e ene e e e eneeeenneeeaes 4-9

Printing from the Handheld DEVICE ......... ..ottt e et e e snee e e ee e e snse e e s neeeeemeeeeaaneeenas 4-10
Prifiting DY AITPTINT s o sum e s s cuss v s v i e s o s s s s v s v 85 4 e s s s doa s v s 4-10
Printing DY IMOPIIA ... oot e e h et et e e s bt ee e e e enae e e e e e s 4-10
Printing With Wi-Fi DIFECT ... ettt ettt et e e et e e e ean e e e e ee s 4-10

Printing Data Saved iN the PHINTEE ...ttt ee e e s et e e ee e e en e e eeennsneeeennns 4-11
Specifying the Job Box from a Computer and Storing the Job ... 4-11
Printing Document from QUICK COPY BOX .......uiiiiiiiiiiieiie et e e e e e e e e ens 4-12
Deleting the Documents Stored in the QUICK COPY BOX .....cocuuiiiiiiriiiieeie e e 4-12
Printing Document from Proof and Hold BOX ..........coiiiiiiie i e 4-13
Deleting the Documents Stored in the Proof and Hold BOX .........ccoiviiiiiii i 4-13
Printing Documents from Private Print BOX ..........oooiiiiiiiiii e e 4-14
Deleting the Documents Stored in the Private Print BOX ........ccccooieiiiiiiiiiiiiiece e 4-14
Printing Document from Stored JOb BOX ......ccuiiiiiiiiiie e e e 4-15
Deleting the Documents Stored in the Stored JOb BOX ........ccciiiiiiiiiiie e 4-15
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Monitoring the Printer Status (Status MONITOr) ............oiiiiiiiiie e ee e 4-17
Accessing the Status MONILOT ...........coiiiiiiii e ee e e s e e e e ettt ee e s esnreaeeesssnneeeeeanes 4-17
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L@ 8 Tl RV AT=0TT402] o| { s S —— 4-17
Printing Progress Tab ..ot et ettt e e s et e e ea e e e e e eane e e e e s 4-18
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Printer Driver Properties Screen

The printer driver Properties screen allows you to configure a variety of print-related settings.
% Printer Driver User Guide

No.

‘m X
‘ ® cickpine \ pae— el collis bighs  Pagergecanid
[ (0
1 [[@== 3 AU
PERRY o S wer weon
B 3
g (maging
Printer profiles
Publishing G
: Factory
El""’ Defautt
I Advanced
item Detail A
= =lQuick Print
Orientation Portrait
% Color Full color
- Collate on
" Duplex Fiip on long edge
!‘ Pages per sheet off
— : Seasic
Source 2 Auto source selection
) Copies 1 |
o Carbon copies o
[ Print preview Save As... 1 Profiles... ’
(I KYOCERE Cancel

[Quick Print] tab

Provides icons that can be used to easily configure frequently used functions. Each time you click an icon, it
changes to an image resembling the print results and applies the settings.

- ? X

i rl .
o £ K

Collate Duplex

[Basic] tab

This tab groups basic functions that are frequently used. You can use it to configure the paper size and duplex
printing.

[Layout] tab

This tab lets you configure settings for printing various layouts, including booklet printing, combine mode,
poster printing, and scaling.

[Imaging] tab

This tab lets you configure settings related to the quality of the print results.

[Publishing] tab

This tab lets you create covers and inserts for print jobs and put inserts between sheets of OHP film.
[Job] tab

This tab lets you configure settings for saving print data from the computer to the machine. Regularly used
documents and other data can be saved to the machine for easy printing later. Since saved documents can
be printed directly from the machine, this function is also convenient when you wish to print a document that
you don't want others to see.

[Advanced] tab

This tab lets you configure settings for adding text pages or watermarks to print data.

[Profiles]

Printer driver settings can be saved as a profile. Saved profiles can be recalled at any time, so it's a
convenient practice to save frequently used settings.

[Reset]
Click to revert settings to their initial values.
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Displaying the Printer Driver Help

The printer driver includes Help. To learn about print settings, open the printer driver print settings screen and display
Help as explained below.

- 1 O 1 Click the [?] button in the upper right corner of
@ o TR the screen.
(4
B sasc . . - . 2 Click the item you want to know about.
A tayou
B4 imaging
(5] pusisting G
L= S
[+ Advanced
NOTE

The Help appears, even when you click the item you want to know about and press the [F1] key on your keyboard.

Changing the Default Printer Driver Settings
(Windows 10)

The default printer driver settings can be changed. By selecting frequently used settings, you can omit steps when
printing. For the settings, refer to the following:

® Printer Driver User Guide

1 Click [Start] button on the Windows and then select [Windows
System], [Control Panel], and [Devices and Printers].

2 Right-click the printer driver icon of the machine, and click the
[Printer properties] menu of the printer driver.

3 Click the [Basic] button on the [General] tab.

4 Select the default settings and click the [OK] button.

4-3



Printing from PC > Printing from PC

Printing from PC

This section provides the printing method using the KX DRIVER.

NOTE
* To print the document from applications, install the printer driver on your computer from the supplied DVD
(Product Library).

* In some environments, the current settings are displayed at the bottom of the printer driver.

g = Quick Print

Orientation Portrait

Color Full color
E= Collate on
= Duplex Flip on long edge
O] Pages per sheet oft
= o = Basic
Source Auto source selection
on copies

OPrint preview

( KYOCERE Goncel

» When printing the cardstock or envelopes, load the cardstock or envelopes in the multipurpose tray before
performing the following procedure.

| oading Paper in the Multipurpose Tray (page 5-2)

Printing on Standard Sized Paper

If you loaded a paper size that is included in the print sizes of the machine, select the paper size in the [Basic] tab of the
print settings screen of the printer driver.

1 Display the screen.
Click [File] and select [Print] in the application.

2 Configure the settings.

1 Select the machine from the "Printer" menu and click the [Properties] button.

Print on both sides of paper
@Fiponlongedge  OFiip on shor edge

it/ landscape

O Portrait
OLandscape

Pagelofs

Page Setup... Print Cancel

2 Select the [Basic] tab.

3 Click "Print size" menu and select the paper size to use for printing.

To load the paper of size that is not included in print sizes of the machine such as cardstock or
envelopes, the paper size needs to be registered.

® Printing on Non-standard Sized Paper (page 4-6)




Printing from PC > Printing from PC

To print on the special paper such as thick paper or transparency, click "Media type" menu and select
the media type.

Collate: On

(o] ®

[ st enhancement

Orientation: Portrait
®@ O o O
Duplex: Flip on long edge

Tar

4 Click [OK] button to return to the Print dialog box.

3 Start printing.
Click the [OK] button.
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Printing on Non-standard Sized Paper

If you loaded a paper size that is not included in the print sizes of the machine, register the paper size in the [Basic] tab
of the print settings screen of the printer driver.

The registered size can be selected from the "Print size" menu.

NOTE

To execute printing at the machine, set the paper size and type in the following:
® Paper Settings (page 6-6)

1 Display the screen.

1 Click [Start] button on the Windows and then select [Windows System], [Control Panel],
and [View devices and printers].

NOTE
In Windows 8.1, in charms on Desktop, click [Settings], [Control Panel], and then
[Devices and Printers].

2 Right-click the printer driver icon of the machine, and click the [Printer properties] menu of
the printer driver.

3 Click the [Basic] button on the [General] tab.

2 Register the paper size.

1 Click the [Basic] tab.

Orientation: Portrait

Ay

®
Duplex: Flip on long edge
0O ® O

Color: Full color

6155 @

® O O [ecoprnt

2 Click the [Page Size...] button.
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3 Click the [New] button.

Page Sizes ? X

Select page size: 210x 297 mm
Envelope #6 ~
Envelope C5
Envelope DL
16K
Oficio Il

216 x 340 mm

v

New | — 3
T[zrss 2] mm [[[2794 F] mm
Name:

Custom_01 —_—

6
)17

Enter the paper size.

Enter the name of the paper.
Click the [Save] button.

Click the [OK] button.

0O N o a b

Click the [OK] button.

|Unspeditied v L o=
® (o] (e) (@]

D{s!vpa!vyn:
| Printer default v
Duplex: Flip on long edge
- Copies: (@) ® o
S = e
Color: Full color
Settings...
®@ O

O [ecoprint
[Ogatch copies
Settings..,
E Item Detail 22
[=Quick Print
=i Orientation Portrait
Color Full color
Collate on
Duplex Fiip on long edge
@ | Pages per sheet off
= « Hasic
¢ L‘ Source Auto source selection
Copies 1
X
Q. Carbon copies off e
[ Print preview Save As... Profiles... |
i KYOCERA 8 (:9‘ el

3 Display the print settings screen.
Click [File] and select [Print] in the application.

4 Select the paper size and type of non-standard size paper.
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1 Select the machine from the "Printer" menu and click the [Properties] button.

prnt x
——  cm—
Printer: ) Properties || Aclnced Help @
e (B
o p— o

Pages to Print Comments & Forms

@ | Document and Markups v
Current page. 1
O Current pag Summarize Comments.
Opages  [1-5 e
» More Options S 0%
449638 Inches

Page Sizing & Handling ()
[ Foste Mg Booklet (LT T
OFit

Octuelsize

(® Shrink oversized pages

OCustomScale: ~ [100 %

[ Choose paper source by PDF page size

[Print on both sides of paper
Orientation:

® Auto portrat/landscape

O Portrait

O Landscape

| Page Setup... Print Cancel |

2 Select the [Basic] tab.

3 Click "Print size" menu and select the paper size registered in step 2.

To print on the special paper such as thick paper or transparency, click "Media type" menu and select
the media type.

Collate: On

fenl)

i
(o] ®

Orientation: Portrait

[A|a V@
@ O O O

[ List enhancement
Source:

| Auto source selection
Media type:
'\, [Unspedtied

Printer default
Duplex: Fiip on long edge

& =

[ carbon copies
Settings...

® O O [Oecoprint

[] Batch copies
Settings...

item Detail A
= Quick Print

—~

NOTE

If you loaded a postcard or envelope, select [Cardstock] or [Envelope] in the "Media
type" menu.

4 Select the paper source in the "Source" menu.

5 Click [OK] button to return to the Print dialog box.

5 Start printing.
Click the [OK] button.
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Canceling Printing from a Computer

To cancel a print job executed using the printer driver before the printer begins printing, do the following:

NOTE
When canceling printing from this machine, refer to the following:

® Canceling Jobs (page 5-5)

1 Double-click the printer icon (/*!) displayed on the taskbar at
the bottom right of the Windows desktop to display a dialog
box for the printer.

2 Click the file for which you wish to cancel printing and select
[Cancel] from the "Document™ menu.
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Printing from the Handheld Device

This machine supports the AirPrint, Mopria and Wi-Fi Direct.

According to the supported OS and application, you can print the job from any handheld device or computer without
installing a printer driver.

Printing by AirPrint

AirPrint is a printing function that is included standard in iOS 4.2 and later products, and Mac OS X 10.7 and later
products.

To use the AirPrint, make sure that the AirPrint setting is enabled in the Command Center RX.

% Command Center RX User Guide

Il Works with
E= Apple AirPrint

Printing by Mopria
Mopria is a standard on printing function included in Android 4.4 or later products. Mopria Print Service needs to be

installed and enabled in advance.

For details on how to use, refer to a Web site of Mopria Alliance.

-
MOoNPrIQY

Printing with Wi-Fi Direct

Wi-Fi Direct is a wireless LAN standard that Wi-Fi Alliance has been established. This is one of the functions of the
wireless LAN, without a wireless LAN access point or wireless LAN router, between devices can communicate directly
on a peer to peer basis.

The printing procedure by the Wi-Fi Direct is the same as that from the normal handheld devices.

When you use a printer name or Bonjour name on the port settings of the printer property, you can print the job by
specifying the name at Wi-Fi Direct connection.

When you use an IP address for the port, specify the IP address of this machine.
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Printing from PC > Printing Data Saved in the Printer

Printing Data Saved in the Printer

You can save the print job into the Job Box of this device and print it as necessary. To use the Stored Job Box and the
Quick Copy Box, an SD/SDHC memory card must be installed in the device.

@ IMPORTANT

Unencrypted data is saved on the SD/SDHC memory card.
Exercise caution when saving sensitive documents.

NOTE

If you are using an SD/SDHC memory card to use a job box, set [RAM Disk Mode] to [Off].

If you configure settings in the [Job] tab of the printer driver and then print, the print job will be saved in the Job Box
(memory) and printing can be executed at the machine.

Follow the work flow below when using Job Box.

Specifying the Job Box from a computer and sending the print job. (page 4-11)

v

Using the operation panel to specify a file within a Box and printing it.

You can print the documents from the following boxes.

® Printing Document from Quick Copy Box (page 4-12)

® Printing Document from Proof and Hold Box (page 4-13)

® Printing Documents from Private Print Box (page 4-14)

® Printing Document from Stored Job Box (page 4-15)

Specifying the Job Box from a Computer and Storing
the Job

1 Click [File] and select [Print] in the application.
The Print dialog box displays.

2 Select the machine from the "Name" menu.

3 Click the [Properties] button.
The Properties dialog box displays.

4 Click the [Job] tab and select the [Job storage (e-MPS)] check
box to set the function.

NOTE

For information on how to use the printer driver software, refer to the following:

® Printer Driver User Guide
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Printing from PC > Printing Data Saved in the Printer

Printing Document from Quick Copy Box

Quick Copy feature facilitates additional prints of a document already printed. Activating Quick Copy and printing a
document using the printer driver allow the print data to be stored in the Quick Copy Job Box. When additional copies
are required, you can reprint the required number of copies from the operation panel. By default, up to 32 documents
can be stored. When power is turned off, all stored jobs will be deleted.

NOTE
* When the number of jobs reaches the limit, the oldest job will be overwritten by the new one.

» To maintain free space on the box, you can set the maximum number of stored jobs.
=® Quick Copy (page 4-16)

1 Display the screen.
1 [Menu] key > [A][V¥] key > [Job Box] > [»>] key > [A] [¥] key > [Quick Copy] > [OK] key

2 Select the creator of the document, and select the [OK] key.

2 Print the document.

1 Select the document to print.
[All Files] > [A][V] key > [OK] key
To apply this process to all documents in Quick Copy/Proof-and-Hold, select [All Files].

2 Specify the number of copies to print as desired, and select the [OK] key.
Printing starts.

NOTE
If you selected [All Files], select [ A] key to set the number of copies. When using the
number of copies specified with print job, select "Copies ---".

Deleting the Documents Stored in the Quick Copy Box

1 Display the screen.
1 [Menu] key > [A][V¥] key > [Job Box] > [»>] key > [A] [¥] key > [Quick Copy] > [OK] key

2 Select the creator of the document, and select the [OK] key.

2 Delete the document.

1 Select the document to delete.
[All Files] > [A] [ V] key > [OK] key
To apply this process to all documents in Quick Copy/Proof-and-Hold, select [All Files].

2 [Delete] appears.

If the [ V] key is selected when "Copies" appears, [Delete] will appear.

3 Select the [OK] key.

The document is deleted.
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Printing from PC > Printing Data Saved in the Printer

Printing Document from Proof and Hold Box

The Proof and Hold feature produces only a single proof print of multiple-print job and holds printing of the remaining
copies. Printing a multiple-print job in Proof and Hold using the printer driver allows only a single copy to be printed while
maintaining the document data in the Job Box. To continue to print the remaining copies, use the operation panel. You
can change the number of copies to print.
1 Display the screen.
1 [Menu] key > [A][V] key > [Job Box] > [»>] key > [A] [¥] key > [Quick Copy] > [OK] key

2 Select the creator of the document, and select the [OK] key.

2 Print the document.

1 Select the document to print.
[All Files] > [A] [ V] key > [OK] key
To apply this process to all documents in Quick Copy/Proof-and-Hold, select [All Files].

2 Specify the number of copies to print as desired, and select the [OK] key.
Printing starts.

NOTE
If you selected [All Files], select [A] key to set the number of copies. When using the
number of copies specified with print job, select "Copies ---".

Deleting the Documents Stored in the Proof and Hold
Box

1 Display the screen.
1 [Menu] key > [A][V] key > [Job Box] > [»>] key > [A] [¥] key > [Quick Copy] > [OK] key

2 Select the creator of the document, and select the [OK] key.

2 Delete the document.

1 Select the document to delete.
[All Files] > [A][ V] key > [OK] key
To apply this process to all documents in Quick Copy/Proof-and-Hold, select [All Files].

2 [Delete] appears.

If the [ V] key is selected when "Copies" appears, [Delete] will appear.

3 Select the [OK] key.

The document is deleted.
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Printing Documents from Private Print Box

In Private Printing, you can specify that a job is not to be printed until you operate the machine. When sending the job
from the application software, specify a 4-digit access code in the printer driver. The job is released for printing by
entering the access code on the operation panel, ensuring confidentiality of the print job. The data will be deleted upon
completion of the print job or after the power switch is turned off.

1 Display the screen.

1

[Menu] key > [A][V] key > [Job Box] > [»] key > [A] [¥] key > [Private/Stored] >
[OK] key

2 Select the creator of the document, and select the [OK] key.

2 Print the document.

1

Select the document to print.
[A][V¥] key > [OK] key > Enter the access code > [OK] key
To apply this process to all documents in Private/Stored Job, select [All Files].

Specify the number of copies to print as desired, and select the [OK] key.
Printing starts.

Upon completion of printing, the Private/Stored job is automatically deleted.

NOTE

* If you selected [All Files] and the access code does not match any of the documents,
and in addition there are no documents without access codes, "ID error" is displayed.

* If you selected [All Files], select [A] key after "Copies ---" is displayed to set the
number of copies.

Deleting the Documents Stored in the Private Print Box

1 Display the screen.

1

[Menu] key > [A][V] key > [Job Box] > [»] key > [A] [¥] key > [Private/Stored] >
[OK] key

2 Select the creator of the document, and select the [OK] key.

2 Delete the document.

1

Select the document to delete.
[A][V¥] key > [OK] key > Enter the access code > [OK] key
To apply this process to all documents in Private/Stored Job, select [All Files].

[Delete] appears.
If the [ V] key is selected when "Copies" appears, [Delete] will appear.

Select the [OK] key.

The document is deleted.

NOTE

If you selected [All Files] and the access code does not match any of the documents,
and in addition there are no documents without access codes, "ID error" is displayed.
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Printing from PC > Printing Data Saved in the Printer

Printing Document from Stored Job Box

In Stored Job, the print data sent from the application is saved to the machine. You can set up an access code as
necessary. If you set up an access code, enter the access code when printing. Print data will be stored in the Stored Job
Box after printing. This will allow printing of the same print data repeatedly.

1 Display the screen.

1 [Menu] key > [A][V¥] key > [Job Box] > [»] key > [A] [¥] key > [Private/Stored] >
[OK] key

2 Select the creator of the document, and select the [OK] key.

2 Print the document.

1 Select the document to print.
[A][V] key > [OK] key > Enter the access code > [OK] key

To apply this process to all documents in Private/Stored Job, select [All Files].

2 Specify the number of copies to print as desired, and select the [OK] key.
Printing starts.

NOTE

* If you selected [All Files] and the access code does not match any of the documents,
and in addition there are no documents without access codes, "ID error" is displayed.

* If you selected [All Files], select [A] key after "Copies ---" is displayed to set the
number of copies.

Deleting the Documents Stored in the Stored Job Box

1 Display the screen.

1 [Menu] key > [A][V¥] key > [Job Box] > [»] key > [A] [¥] key > [Private/Stored] >
[OK] key

2 Select the creator of the document, and select the [OK] key.

2 Print and delete the document.

1 Select the document to delete.
[A][V¥] key > [OK] key > Enter the access code > [OK] key

To apply this process to all documents in Private/Stored Job, select [All Files].

2 [Delete] appears.

If the [ V] key is selected when "Copies" appears, [Delete] will appear.

3 Select the [OK] key.

The document is deleted.

NOTE

If you selected [All Files] and the access code does not match any of the documents,
and in addition there are no documents without access codes, "ID error" is displayed.
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Job Box Setting

Configures settings for Job Box.

1 Display the screen.

[Menu] key > [A] [¥] key > [Job Box] > [»] key > [A][V¥] key > [Job Box Configuration] >
[»>] key

2 Configure the settings.

The available settings are shown below.

Item Description

Quick Copy To maintain free space on the box, you can set the maximum number of
stored jobs.

Value: 0 to 300

NOTE

When 0 is set, Quick Copy cannot be used.

Delete This setting specifies that documents, such as Private Printing, Quick
Copying, or Proof and Hold Printing, saved temporarily in the job box are
automatically deleted after they have been saved for a set time.

Value: Off, 1 hour, 4 hours, 1 day, 1 week

NOTE

This function is valid for documents saved after the function is set.
Regardless of this function setting, temporary documents are deleted
when the main power switch is turned off.




Printing from PC > Monitoring the Printer Status (Status Monitor)

Monitoring the Printer Status (Status
Monitor)

The Status Monitor monitors the machine status and provides an ongoing reporting function.

NOTE

When you activate Status Monitor, check the status below.
* KX DRIVER is installed.
+ Either [Enhanced_WSD] or [Enhanced WSD(SSL)] is enabled.

» Network Settings (page 6-13)

Accessing the Status Monitor

The Status Monitor also starts up when printing is started.

Exiting the Status Monitor

Use either of the methods listed below to exit the Status Monitor.

* Exit manually:
Click the settings icon and select Exit in the menu to exit the Status Monitor.

» Exit automatically:
The Status Monitor automatically shuts down after 7 minutes if it is not being used.

Quick View State

The status of the machine is displayed using icons. Detailed information is displayed when the Expand button is clicked.

Printing progress tab
Paper tray status tab

- - O X
l!ﬂf[l Jid= T

‘ % 30‘)] |99% 49%  66% 65% |
| 7

1 2 45 6

’

1

2

3 Toner status tab
4 Alert tab
5
6

Expand button

Settings icon
Detailed information is displayed by clicking on each icon tab.

4-17



Printing from PC > Monitoring the Printer Status (Status Monitor)

Printing Progress Tab
The status of the print jobs is displayed.

3

1 Status icon
- m} X

IDD A= ) 2 Job list

(I

A
n

[ 1
0% 0%

a
=)

82% 93% 93%

a

Job Name Printed ... Status

; 2

1

Select a job on the job list and it can be canceled using the menu displayed with a right-click.

Paper Tray Status Tab

Information is displayed about the paper in the printer and about the amount of paper remaining.

& ) - o x|
J@@ Jon = =
0% 0% | 829 093% 93% 93% o
Name Size Type Level
A\MP Tray Legal Plain 0%
A\ Cassette 1 A4 Plain 0%
,
Toner Status Tab
The amount of toner remaining is displayed.
- o x|
100 = ©

82% 93% 93% 93%

&
Toner Level Name
Black 82% TK-5242KS
Cyan 93% TK-5242CS
Magenta 93% TK-5242MS
Yellow 93% TK-5242YS |
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Alert Tab

If an error occurs, a notice is displayed using a 3D image and a message.

‘ e - o X
== J 0 ) 0= @
7> 7@\ P;:per !ernr1pty -

Cassette 1 is empty.
Add paper to the cassette

Status Monitor Context Menu

The following menu is displayed when the settings icon is clicked.

R - O X

=z3000 I e—— ©

Notification...

|

@® Paper canng
A\ Paper empty

www.kyoceradocumentsolutions.com

Exit

« Command Center RX
If the printer is connected to a TCP/IP network and has its own IP address, use a web browser to access the
Command Center RX to modify or confirm the network settings. This menu is not displayed when using USB
connection.

= Command Center RX User Guide

* Notification...
This sets the display of the Status Monitor.

® Status Monitor Notification Settings (page 4-20)

* www.kyoceradocumentsolutions.com
Open our website.

« Exit
Exits the Status Monitor.
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Status Monitor Notification Settings

Click the setting icon to display valid events in the status monitor notification screen.

X

Ayailable events:

Events Sound file / Text to Speech
Cover open
Paper jam
Add paper
Sleep
Add toner
Toner low
Not connected
Printing completed
Others
cares

Select whether notification is performed when an error in the event list occurs.

1 Select Enable event notification.

If this setting is set to Off, then the Status Monitor will not start up even when printing is
executed.

2 Select an event to use with the text to speech function in
Available events.

3 Click Sound file / Text to Speech column.
Click the browse (...) button to notify the event by sound file.
‘77 7 7 X

| Enables event notification.

Available events:

Events Sound file / Text to Speech

Cover open [

NOTE

The available file format is WAV.

When customizing the message texts to read on the screen aloud, enter the texts in the text box.
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Operation on the Machine or Work from Your Home > Loading Paper in the Multipurpose Tray

Loading Paper in the Multipurpose Tray

For details of the supported paper sizes, refer to the following:

® Choosing the Appropriate Paper (page 9-9)

For the paper type setting, refer to the following:
® Type Adjust Setting (page 6-7)

Be sure to use the multipurpose tray when you print on any special paper.

@ IMPORTANT

« If you are using a paper weight of 106 g/m? or more, set the media type to Thick and set the weight of the
paper you are using.

* Remove each transparency from the top tray as it is printed. Leaving transparencies in the top tray may
cause a paper jam.
The capacity of the multipurpose tray is as follows.
«  Plain paper (80 g/m?), recycled paper or color paper: 50 sheets
«  Thick paper (209 g/m?): 15 sheets
+  Thick paper (157 g/m?): 30 sheets
« Thick paper (104.7 g/m?): 50 sheets
* Hagaki (Cardstock): 15 sheets

* Envelope DL, Envelope C5, Envelope #10, Envelope #9, Envelope #6 3/4, Envelope Monarch, Youkei 4, Youkei 2:
5 sheets

¢ OHP film: 1 sheet
¢ Coated: 15 sheets

NOTE

* When you load custom size paper, enter the paper size by referring to the following:
® MP Tray Size (page 6-6)

* When you use special paper such as transparencies or thick paper, select the media type by referring to the
following:

% MP Tray Type (page 6-6)

1 Open the multipurpose tray.
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Operation on the Machine or Work from Your Home > Loading Paper in the Multipurpose Tray

2 Adjust the multipurpose tray size.

Paper sizes are marked on the multipurpose tray.

6ol sml
STMT

Ea m A5D

Bsol A4D|
A5

8,LTR/LGLD

Load paper.
3

Insert the paper along the paper width guides into the tray until it stops.

After removing new paper from its packaging, fan the paper before loading it in the

multipurpose tray.

® Precaution for Loading Paper (page 3-2)

@ IMPORTANT

* When loading the paper, keep the print side facing up.

e Curled paper must be uncurled before use.

« When loading paper into the multipurpose tray, check that there is no paper left
over in the tray from a previous job before loading the paper. If there is just a small
amount of paper left over in the multipurpose tray and you want to add more, first
remove the left-over paper from the tray and include it with the new paper before
loading the paper back into the tray.

« If there is a gap between the paper and the paper width guides, readjust the guides
to fit the paper in order to prevent skewed feeding and paper jams.

* Ensure that the loaded paper does not exceed the load limits.

Specify the type of paper loaded in the multipurpose tray using
the operation panel.

= MP Tray Type (page 6-6)
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Operation on the Machine or Work from Your Home > Loading Paper in the Multipurpose Tray

When you load envelopes or cardstock in the multipurpose tray
Load the paper with the print side facing up. For the procedure for printing, refer to the following:
® Printer Driver User Guide

Example: When printing the address.

1 Oufuku hagaki (Return
postcard)

2 Hagaki (Cardstocks)

Portrait form envelopes

Landscape form envelopes

(©) IMPORTANT
» Use unfolded Oufuku hagaki (Return postcard).

* How to load envelopes (orientation and facing) will differ depending on the type of envelope. Be sure to
load it in correctly, otherwise printing may be done in the wrong direction or on the wrong face.

NOTE
When you load envelopes in the multipurpose tray, select the envelope type by referring to the following:

% MP Tray Type (page 6-6)




Operation on the Machine or Work from Your Home > Canceling Jobs

Canceling Jobs

1 While the printer displays "Processing”, select [Cancel] key.

"?" appears on the message display followed by the job name currently in progress.

2 Cancel a job.
Select the job to cancel, and select the [OK] key.

The job is canceled.
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Operation on the Machine or Work from Your Home > Using Document Boxes

Using Document Boxes

The available Document Boxes are as follows: Job Box and Removable Memory Box.

What is Job Box?

Job Box is a generic name for the "Private Print/Stored Job Box" and "Quick Copy/Proof and Hold Box". These Job
Boxes cannot be created or deleted by a user.

NOTE
» To use the Stored Job Box and the Quick Copy Box, an SD/SDHC memory card must be installed in the device.
* You can set up the machine so that temporary documents in job boxes are automatically deleted.

® Delete (page 4-16)
* For details on operating the Job Box, refer to the following:
® Printing Data Saved in the Printer (page 4-11)

@ IMPORTANT

Unencrypted data is saved on the SD/SDHC memory card.
Exercise caution when saving sensitive documents.

What is USB Drive Box?

A USB drive can be connected to the USB Port on the machine to print a saved file. You can print data directly from the
USB drive without a PC.
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Operation on the Machine or Work from Your Home > Operating using Removable USB Drive

Operating using Removable USB Drive

Plugging USB drive directly into the machine enables you to quickly and easily print the files stored in the USB drive
without having to use a computer.

The following file types can be printed:

PDF file (Version 1.7 or older)
TIFF file (TIFF V6/TTN2 format)
JPEG file

XPS file

OpenXPS file

Encrypted PDF file

Printing Documents Stored in Removable USB Drive

NOTE

» PDF files you wish to print should have an extension (.pdf).
* Files to be printed should be saved no further down than the top 3 folder levels, including the root folder.

* Plug the USB drive directly into the USB Port.

1 Plug the USB drive.
Plug the USB drive into the USB Port.

2 Display the screen.
[Menu] key > [A] [¥] key > [USB Drive] > [»>] key
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Operation on the Machine or Work from Your Home > Operating using Removable USB Drive

3 Print the document.

[A][V] key > [Print File] > [OK] key > [OK] key
Select the document, and select the [OK] key.
Select the [OK] key.

A O N =

Enter the print quantity, and select the [OK] key.

You can select a number between 001 and 999 as the number of copies.

5 Select the desired paper source and select the [OK] key.

Printing of the selected file begins.

Print a file list

1 Display the screen.
[Menu] key > [A] [¥] key > [USB Drive] > [»>] key

2 Print a file list.
[A][V¥]key > [Print File List] > [OK] key > [OK] key

You can print a list of the files in USB drive.

Removing USB Drive

(©) IMPORTANT
Be sure to follow the proper procedure to avoid damaging the data or USB drive.

1 Display the screen.
[Menu] key > [A] [¥] key > [USB Drive] > [»>] key

2 Select [Remove Devicel.
[A][V¥]key > [Remove Device] > [OK] key > [OK] key

3 Remove the USB drive.
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Operation on the Machine or Work from Your Home > Remote Work Assistant

Remote Work Assistant

The Kyocera Remote Work Assistant application provides tools when working remotely from your home.
The Kyocera Remote Work Assistant has the following functions.

» Counter: You can view and export print counter information.

* Log Settings: You can store images and job logs for print jobs.

For details on how to install and operate the Kyocera Remote Work Assistant, refer to the following.

® Kyocera Remote Work Assistant User Guide
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Setup and Registration (System Menu) > System Menu

System Menu

Configure settings related to overall machine operation.

Operation Method

Select the [Menu] key to show the settings on the message display. Then, select from the settings displayed.

# Operation Method (page 2-11)

NOTE

In order to change settings that require administer privileges, you must log in with administrator privileges.

The factory default administrator ID and administrator password are both set as 2100.

Refer to Menu Settings on the following page and configure as needed.
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Menu Settings

This section explains the functions that can be configured in Menu. To configure the settings, select the item in System
Menu and select the setting item. For details on each function, see the table below.

Item Description Reference Page
Print Report Print reports to check the machine settings and status. page 6-4
Counter Check the number of sheets printed. page 2-43
Paper Settings Configure settings for paper. page 6-6
Print Settings Configure settings for printing. page 6-8
Wi-Fi Direct Set Set Wi-Fi Direct. page 6-10
Wi-Fi Settings Set Wi-Fi. page 6-10
Wired Network Configure wired network settings. page 6-12
Network Settings Configure network settings. page 6-13
Message Language Select the language displayed on the message display. page 6-17
Date Setting Configure settings related to the date and time. page 6-17
Buzzer Set options for buzzer sound during the machine operations. page 6-18
RAM Disk Mode A RAM disk can be created and its size can be set. page 6-18
SD Card Format an SD/SDHC memory card. page 6-18
Error Handling Select whether to cancel or continue the job when error has occurred. page 6-19
ColorToner Empty Select whether printing is prohibited or the Print in Black and White page 6-19
setting is used for printing once the color toner runs out.
Timer Configure settings related to the time. page 6-19
Sleep Level Set. Select the Sleep level. page 6-20
Power Off Rule (models for Select whether or not the machine enters Power Off mode. page 6-20
Europe)
Power Off Timer (models for Select whether to turn off the power automatically after a period of page 6-21
Europe) inactivity.
Disp. Status/Log Set the display method of the Status/Log. page 6-21
Low Toner Alert Set the amount of remaining toner to notify the administrator when to page 6-21
order a toner when the toner is running low.
Security The security functions can be set up to protect printer operation and the | page 6-22
print data.
I/F Block This allows you to protect this machine by blocking the interface with page 6-22

external devices such as USB hosts.

Security Level

The Security Level setting is primarily a menu option used by service
personnel for maintenance work. There is no need for customers to use
this menu.

User/Job Account

Configures settings related to machine management.
User Login:

> Overview of User Login Administration (page 7-2)

Job Accounting:

B Overview of Job Accounting (page 7-6)
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Item Description Reference Page
Administrator The Administrator setting is a function that identifies a user who can use | page 6-24
the printer and manage other users.
Adjust/Maintenance Adjust printing quality and conduct machine maintenance. page 6-24
Restart Printer Restart the machine without turning the power switch off. Use this to deal | page 6-24
with any unstable operation by the machine. (Same as the computer
restart.)
Op functions You can use the optional applications installed on this machine. page 6-23
Wired Status The wired network connection status appears. page 6-24
Wi-Fi Status The wireless LAN status appears. page 6-24
Wi-Fi Direct Information on the device that is connected by Wi-Fi Direct appears. page 6-26

Report Print

Print reports to check the machine settings and status.

[Menu] key > [A] [ VY] key > [Report Print] > [»>] key

Item Description

Print Menu Map Prints Menu Map to check the settings of the machine.

Menu Map 0} KYOCERA

Print Status Page Prints the status page, allowing you to check the information including current settings, memory
capacity, and optional equipment installed.

Status Page () KYOCERA

Firmware Version

\/—\
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Item Description

Print Fonts List Prints the font list, allowing you to check the font samples installed in the machine.

I_ [eresonse |

Font Name | [scaiabiersitmap] [ Ppasswore d_ | [ selectio [FSET] Fontip |
L LLI1]1] [ LL{1]1} [ 11]] NENNENNERREEY (111}

Font Name Scalable/Bitmap] | _Password | | Selection  [FSET] Font ID LLLL]
[T nRRERED [T AENEREREEEONN [T LLLL]

==

[LLIL]1}) (111}
EREEEREN (111}
[ L111]] (111
ANENEREND EREEEER (111}

(L1111} (LIILL]] (111} ANENERNENNAND anEe
AEENEREND apEEEml (111} AEEREREEREENN (111}
amREEEm

asREmEm
LU

Print RAM Disk File List You can print a list of the files in the RAM disk.

NOTE

This setting is displayed when [RAM Disk Mode] is set to [On].

Print SD Card File List You can print a list of the files in the SD Card.

NOTE

Displayed when the SD Card is installed.

Print Data Sanitization Report | Prints the data sanitization report.




Setup and Registration (System Menu) > System Menu

Paper Settings
[Menu] key > [A] [ V] key > [Paper Settings] > [»>] key

Configure settings for paper.

Item Description

MP Tray Size Select the paper size to be used in the multipurpose tray.

Values: Envelope Monarch, Envelope #10, Envelope DL, Envelope C5, Executive, Letter,
Legal, A4, B5, A5-R, A5, A6, B6, Envelope #9, Envelope #6, ISO B5, Custom,

Hagaki (Cardstock), OufukuHagaki (Return postcard), Oficio Il, 216 x 340 mm, 16K,
Statement-R, Statement, Folio, Youkei 2, Youkei 4

MP Tray Type*1 Select the media type of paper to be used in the multipurpose tray.

Values: PLAIN (60 - 105 g/m?), TRANSPARENCY, PREPRINTED, LABELS, BOND,
RECYCLED, VELLUM (60 - 220 g/m?), ROUGH, LETTERHEAD, COLOR, PREPUNCHED,
ENVELOPE, CARDSTOCK, COATED, THICK (106 - 220 g/m?), HIGH QUALITY,

Custom 1to 8

Cassette1 (2) Size™ Select the paper size to be used in Cassette 1 (2).

Values: Executive, Letter, Legal, A4, B5, A5-R, A5, A6, B6, ISO B5, Custom, Oficio ll,
216 x 340 mm, 16K, Statement-R, Folio

If custom is selected, register the custom sizes used in cassette 1 (2).

Values
Metric
X: 105 to 216 mm (in 1 mm increments)
Y: 148 to 356 mm (in 1 mm increments)
Inch
X: 4.13 to 8.50" (in 0.01" increments)
Y: 5.83 to 14.02" (in 0.01" increments)
X=Length, Y=Width
Vertical
X

S I S  S— |

Cassette1 (2) Type™ Select the media type of paper to be used in Cassette 1 (2).
Values: PLAIN (60 - 105 g/m?), PREPRINTED, BOND, RECYCLED, ROUGH,

LETTERHEAD, COLOR, PREPUNCHED, THICK (106 - 163 glmz), HIGH QUALITY,
Custom 1to 8

Type Adjust Select weight for each media type.
For Custom 1 to 8, settings for duplex printing and media type name can be changed.

P Type Adjust Setting (page 6-7)

Reset Type Adjust Resets the attribute settings of all media types set in "Media Type Set".
= Type Adjust Setting (page 6-7)

Paper Setup Msg Set whether to display the confirmation screen for the paper setting when a new paper is set for
each cassette.
MP Tray

Values: On, Off
Cassette 1 (2)

NOTE

[Cassette 2] is displayed when the optional paper feeder is installed.

*1  To change to a media type other than "Plain".
® Type Adjust Setting (page 6-7)
*2  Only set this when the size dial on the cassette is set to "Other".
*3 To change to a media type other than "Plain".
2 Type Adjust Setting (page 6-7)
When a paper weight that cannot be loaded in the cassette is set for a media type, that media type does not appear.

6-6
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Type Adjust Setting

The following media type and paper weight combinations are available.

Paper Weight

Weight (g/m?)

Paper Weight

Weight (g/m?)

Light 52 g/m? to 59 g/m? Heavy 1™ 106 g/m? to 135 g/m?
Normal 1 60 g/m? to 74 g/m? Heavy 2™ 136 g/m? to 163 g/m?
Normal 2 75 g/m? to 90 g/m? Heavy 3™ 164 g/m? to 220 g/m?
Normal 3 91 g/m? to 105 g/m? Extra Heavy "’ Transparencies

*1  The processing speed will be slower than normal.

Each media type's default weight is indicated.

Media Type Default Media Type Default

PLAIN Normal 2 COLOR Normal 2
ROUGH Normal 3 PREPUNCHED Normal 2
VELLUM Heavy 1 LETTERHEAD Normal 2
LABELS Heavy 1 ENVELOPE Heavy 2
RECYCLED Normal 2 THICK Heavy 2
PREPRINTED Normal 2 HIGH QUALITY Normal 2
BOND Normal 3 COATED Heavy 1
CARDSTOCK Heavy 3 CUSTOM 1to 8 Normal 2

For Custom 1 to 8, settings for duplex printing can be changed.

Duplex Path Enable

Duplex printing allowed.

Description

Disable

Duplex printing not allowed.
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Print Settings
[Menu] key > [A] [ V] key > [Print Settings] > [»>] key

Configure settings for printing.

Item Description

Paper Source Select the default paper source from Cassette 1 (2) and multipurpose tray.
Values: MP Tray, Cassette 1 (2)

NOTE

[Cassette 2] is shown when the optional paper feeder is installed.

Auto Cass.Change Select the following actions when the paper runs out in the paper source while printing.
Values: On, Off

NOTE

When selecting [Off], the machine displays "Load Cassette #" (# is a cassette number) or
"Load MP Tray", and stops printing.

Load the paper according to the paper source displayed to resume printing.

To print from the other paper cassette, select [A] or [ ¥] key to display "Use alternative?",
select [A] or [ V] key to select the desired paper source, and then select the [OK] key.

When selecting [On], the machine continues printing automatically when the other cassette
contains the same paper as the currently-used cassette.

MP Tray Priority If paper is set in the multipurpose tray then it is possible for priority to be given to that
multipurpose tray in the paper feed.

Values
Off: The printer driver settings are followed.

Auto Feed: If Auto is selected in the printer driver and there is paper in the multipurpose
tray then the paper feed will be from the multipurpose tray.

Always: If there is paper in the multipurpose tray then the paper feed will be from the
multipurpose tray regardless of what is set in the printer driver.

Paper Feed Mode While printing from the computer, select how to feed paper when the paper source and type are
specified.

Values

Auto: Search the paper source that matches the selected paper size and type.

Fixed: Print on paper loaded in the specified paper source.

Duplex Select binding orientation for duplex mode.
Values: Off, Short edge bind, Long edge bind

Override A4/LT Select whether to treat A4 size and Letter, which are similar in size, as the same size when
printing.

Values

Off: A4 and Letter are not regarded as the same in size.

On: A4 and Letter are regarded as the same in size. The machine will use whichever size
is in the paper source.

Emulation Select the emulation for operating this machine by commands oriented to other types of
printers.
Values: PCL 6, KPDL, KPDL(Auto)
Error Report When you have selected [KPDL] or [KPDL (Auto)], select the [»] key to set "Error Report".
Values: Off, On
Color Mode You can choose whether reports are printed in color or black and white.

Values: Black & White, Color
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Item Description

Print Quality Set the Print Quality.
Gloss Mode Gloss Mode increases the effect of glossiness in printing. However, printing takes longer time.
Values: Off, On

(©) IMPORTANT
Gloss mode is not available when [LABELS] and [TRANSPARENCY] is selected as the
paper type setting.

o Cassetiel (2) Type (page 6-6)
MP Tray Type (page 6-6)

Depending on the paper used, printing in gloss mode may cause curl in paper.
To reduce curl, try using thicker paper.

EcoPrint Mode EcoPrint conserves toner when printing. This is recommended for test copies where faded
printing is not a problem.
Values: Off, On

Resolution Set the resolution used for printing.

Value: 1200 dpi, 600 dpi

NOTE

Settings that are received from the printer driver have priority over the operation panel settings.

Page Setting You can set print preferences such as the number of pages and print orientation.

Copies Set the default number of copies, from 1 to 999.
Value: 1 to 999 copies

Orientation You can select portrait (upright) or landscape (sideways) page orientation.
Value: Portrait, Landscape

Wide A4 Turn this to on to increase the maximum number of characters that can be printed in a line for
an A4 page (78 characters at 10 pitch) and Letter size page (80 characters at 10 pitch). This
setting is only effective in PCL 6 emulation.

Value: Off, On
XPS FitTo Page Set the default value for the XPS fit to page function.
Value: Off, On
TIFF/JPEG Size Select the image size (resolution) when printing JPEG or TIFF file.
Value: Paper Size, Image Resolution, Print Resolution
User Name Set whether the user name set in the printer driver is displayed.
Value: Off, On
Job Name Set whether the job name set in the printer driver is displayed.

Value: Off, Job Name, Job No.+Job Name, Job Name+Job No.

Job Terminator You can select the condition which regarded as a job termination if the print job could not be
processed until the end due to your environment and the other reason.
Value:
EOJ: The command recognized as a termination of the job data is regarded as one job until it is
detected.
End of Session: The data included in a network session at network connection is regarded as
one job.

UEL: The UEL included in the termination of the job data is regarded as one job until it is
detected.
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Wi-Fi Direct Set

[Menu] key > [A] [ Y] key > [Wi-Fi Direct Set] > [»] key
Set Wi-Fi Direct.

NOTE

This function is displayed when the wireless network function is available on the machine.

Wi-Fi Direct
Item Description

Wi-Fi Direct Select whether to use Wi-Fi Direct.
Value: Off, On

Auto Disconnect Automatically disconnect devices connected through Wi-Fi Direct.
Value: Off, On
NOTE
This function is displayed when [Wi-Fi Direct] is set to [On].

Timer (Day:Hour:Min) If you select [ON] to Auto Disconnect, set the waiting time for automatic disconnection.

Value: Day (00 to 99), Hour (00 to 23), Minute (00 to 59)

Wi-Fi Settings
[Menu] key > [A] [ V] key > [Wi-Fi Settings] > [>] key
Set Wi-Fi.

NOTE

This function is displayed when the wireless network function is available on the machine.

Wi-Fi
Description
Wi-Fi Select whether to use Wi-Fi.
Value: Off, On
Quick Setup
Item Description
Quick Setup If the machine will connect to an access point that supports the automatic wireless network

setup, connection settings can be configured by Quick Setup.

Push Button If the access point supports the push button method, wireless settings can be configured using
the push button. This setting executes push button, and the connection is started by pressing
the push button on the access point.

NOTE

The push button method supports only the WPS.

PIN(Device) Starts connection using the machine's PIN code. Enter the PIN code into the access point. The
PIN code of the machine is automatically generated.
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TCP/IP

Item Description

TCP/IP Select whether to use TCP/IP (IPv4) Protocol.
Value: Off, On

DHCP Select whether to use the DHCP (IPv4) server.
Value: Off, On

Auto-IP Select whether to use Auto-IP.
Value: Off, On

IP Address Set the IP address.
Value: #HE HEHE HEHE HHE

NOTE

When DHCP is set to [On], this item is displayed only and cannot be entered.

Subnet Mask Set the IP subnet mask.
Value: #iHt i #HHE HHE

NOTE

When DHCP is set to [On], this item is displayed only and cannot be entered.

Gateway Set the IP gateway address.
Value: #HH HHHE HHHE

NOTE

When DHCP is set to [On], this item is displayed only and cannot be entered.

@ IMPORTANT
* When setting the Auto-IP, enter "0.0.0.0" in [IP Address].

» After changing the setting, restart the network or turn the machine OFF and then ON.
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TCPI/IP (IPv6)
Item Description
TCP/IP (IPv6) Select whether to use TCP/IP (IPv6).

Value: Off, On

RA(Stateless) Select whether to use RA (Stateless).
Value: Off, On
NOTE
This function is displayed when [TCP/IP (IPv6)] is set to [On].

DHCPvé6 Select whether to use the DHCP (IPv6) server.
Value: Off, On
NOTE
This function is displayed when [TCP/IP (IPv6)] is set to [On].

(&) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

Restart Network

Description

Restart Network Restarts the network.

Wired Network

[Menu] key > [A] [ VY] key > [Wired Network] > [»] key

Configure wired network settings.

Item Description

TCP/IP For details on setting value.
= TCP/IP (page 6-11)

TCP/IP (IPv6) For details on setting value.
= TCP/IP (IPv6) (page 6-12)

LAN Interface Specify the settings for the LAN interface to be used.
Value: Auto, 10BASE-Half, 10BASE-Full, 100BASE-Half, 100BASE-Full, 1000BASE-T

Restart Network Restarts the network.

(&) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

6-12
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Network Settings
[Menu] key > [A] [ V] key > [Network Settings] > [»] key

Configure network settings.

Item Description

Communication™

Select the network to be used for the send function and the network authentication.
Value: Wi-Fi, Wired Network

SSL Server Select whether to use SSL.
Value: Off, On
IPSec Select whether to use IPSec.
Value: Off, On
Bonjour Select whether to use Bonjour.
Value: Off, On
NOTE
This function is displayed when TCP/IP is set to [On].
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [Bonjour] is set to [On].

NetBEUI Selects whether to receive documents using NetBEUI. 2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [NetBEUI] is set to [On].

SNMPv3 Select whether to communicate using SNMPv3."2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi™t Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [SNMPv3] is set to [On].

FTP(Server) Select whether to receive documents using FTP."?
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [FTP(Server)] is set to [On].
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Item Description

SNMP Select whether to communicate using SNMP.2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [SNMP] is set to [On].

SMTP Select whether to send E-mail using SMTP.
Value: Off, On
POP3 Select whether to receive E-mail using POP3.
Value: Off, On
RAW_Port Select whether to receive documents using Raw Port."2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [RAW_Port] is set to [On].

LPD Selects whether to receive documents using LPD."
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [LPD] is set to [On].

IPP Selects whether to receive documents using IPP. To use the IPP protocol, select [Not Secure
(IPP&IPPS)] on IPP Security under Security Settings from the Command Center RX. % ™3
Value: Off, On
Wi-Fi Direct ™! Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [IPP] is set to [On].

IPP over SSL

Select whether or not to use IPP over SSL."2: "3
Value: Off, On

NOTE

When selecting [On], it also requires a certificate for SSL. the default certificate is the
self-certificate of the machine.

% Command Center RX User Guide

Wi-Fi Direct™

Wi-Fi!

Wired Network

Set whether to enable this function for each network.
Value: Disable, Enable

NOTE

This function is displayed when [IPP over SSL] is set to [On].
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Item Description

HTTP Select whether to communicate using HTTP.2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network NOTE
This function is displayed when [HTTP] is set to [On].

HTTPS Select whether to communicate using HTTPS.? ™3
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network NOTE
This function is displayed when [HTTPS] is set to [On].

ThinPrint Select whether to use ThinPrint.2 "3
Value: Off, On

NOTE

This function is displayed only when the optional ThinPrint Option is activated.

Wi-Fi Direct™ Set whether to enable this function for each network.
Value: Disable, Enable

Wi-Fi!

Wired Network NOTE
This function is displayed when [ThinPrint] is set to [On].
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Item Description

ThinPrint over SSL To use the Thin Print over SSL protocol, set [ThinPrint Over SSL] to [On]. % ™3
Value: Off, On

NOTE
» This function is displayed when [ThinPrint] is set to [On].

* When selecting [On], it also requires a certificate for SSL. The default certificate is the
self-certificate of the machine.

% Command Center RX User Guide

Wi-Fi Direct™ Set whether to enable this function for each network.
Value: Disable, Enable

Wi-Fi™t
Wired Network NOTE
This function is displayed when [ThinPrint over SSL] is set to [On].

WSD-PRINT Set whether to use our proprietary web services.
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.

Wi-Fi'! Value: Disable, Enable

Wired Network NOTE
This function is displayed when [WSD-PRINT] is set to [On].

Enhanced_WSD Set whether to use our proprietary web services.?
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.

Wi-Fi'! Value: Disable, Enable

Wired Network NOTE
This function is displayed when [Enhanced_WSD] is set to [On].

EnhancedWSD(SSL) Set whether to use our proprietary web services over SSL."% "3
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network NOTE
This function is displayed when [EnhancedWSD(SSL)] is set to [On].

*1 Displayed only when wireless network function is available on the machine.
*2 The setting will be changed after restarting the device or network.
*3 Set [SSL Server] to [On] in Network Settings.

P SSL Server (page 6-13)

(©) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.
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Device Common

Configures overall machine operation.

Message Language

[Menu] key > [A] [V] key > [Device Common] > [»>] key > [A] [V] key > [Message Language] > [OK] key

Description

Message Language Select the language displayed on the message display.

Date Setting
[Menu] key > [A] [ V] key > [Device Common] > [»>] key > [A] [V] key > [Date Setting] > [»>] key

Configure settings related to the date and time.

Item Description

Date (Year/Mon/Day) Set the date for the location where you use the machine.
Value: Year (2000 to 2035), Month (01 to 12), Day (01 to 31)

= Setting Date and Time (page 2-15)

NOTE

If you change the date while using the trial version of an application, you will no longer be able
to use the application.

Time (Hour:Min:Sec) Set the date and time for the location where you use the machine.
Value: Hour (00 to 23), Minute (00 to 59), Second (00 to 59)

®» Setting Date and Time (page 2-15)

NOTE

If you change the time while using the trial version of an application, you will no longer be able
to use the application.

Date Format Select the display format of year, month, and date. The year is displayed in Western notation.
Value: Month/Day/Year, Day/Month/Year, Year/Month/Day

Time Zone Set the time difference from GMT. Choose the nearest listed location from the list. If you select
a region that utilizes summer time, configure settings for summer time.

# Setting Date and Time (page 2-15)

Summer Time
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Buzzer
[Menu] key > [A] [V] key > [Device Common] > [»>] key > [A] [V] key > [Buzzer] > [»>] key

Set options for buzzer sound during the machine operations.

Item Description

Key Confirmation Emit a sound when a key is selected on the operation panel.
Value: On, Off
Job End Emit a sound when a print job is normally completed.
Value: On, Off
Ready Emit a sound when the warm-up is completed.
Value: On, Off
Error Emit a sound when errors occur.
Value: On, Off

RAM Disk Mode
[Menu] key > [A] [ V] key > [Device Common] > [>] key > [A] [V] key > [RAM Disk Mode] > [OK] key

Item Description

RAM Disk Mode A RAM disk can be created and its size can be set.

Creating a RAM disk makes it possible to print from a Job Box.
Value

RAM Disk Mode: On, Off

RAM Disk Size: The setting range varies depending on the amount of memory installed
and the option memory usage setting.

(©) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

SD Card
[Menu] key > [A] [V] key > [Device Common] > [»>] key > [A] [V] key > [SD Card] > [»>] key
Format an SD/SDHC memory card.

A new SD card must be formatted before it can be used in the machine.

(©) IMPORTANT
Formatting will destroy any existing data on a storage device including a used SD card.
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Error Handling
[Menu] key > [A][V¥] key > [Device Common] > [»] key > [A] [ V] key > [Error Handling] > [»>] key

Select whether to cancel or continue the job when error has occurred.

Item Description

Duplex Select what to do when duplex printing is not possible for the selected paper size and media type.
Value

Off: Printed in 1-sided

On: Message to cancel printing is displayed.

Paper Mismatch Select what to do when the selected paper size or type does not match paper size or type
loaded in the specified paper source while printing from the computer by specifying the
cassette or multipurpose tray.

Value
Off: The setting is ignored and the job is printed.
On: Message to cancel printing is displayed.

MP Tray Empty Turn this setting to [On] if you want the error displayed when the multipurpose tray is
configured as the default paper source, and there is no paper in the multipurpose tray, or turn it
to [Off] not to have the error displayed.

Value: On, Off

ColorToner Empty
[Menu] key > [A] [V] key > [Device Common] > [»>] key > [A] [V] key > [ColorToner Empty] > [OK] key

Description

ColorToner Empty Select whether printing is prohibited or the Print in Black and White setting is used for printing
once the color toner runs out.

Value: Stop printing, PrintinB & W

Timer
[Menu] key > [A] [ V] key > [Device Common] > [»>] key > [A] [V] key > [Timer] > [»] key

Configure settings related to the time.

Item Description

Auto Panel Reset If no jobs are run for a certain period of time, automatically reset settings and return to the
default setting. Select to use Auto Panel Reset or not.

Value: Off, On

NOTE

The time allowed to elapse before the panel is reset is set with the following:

®» Panel Reset Timer (page 6-19)

Panel Reset Timer If you select [On] for Auto Panel Reset, set the amount of time to wait before Auto Panel Reset.
Value: 5 to 495 seconds (in 5 second increments)

NOTE

This function is displayed when [Auto Panel Reset] is set to [On].

Sleep Timer Set amount of time before entering Sleep.
Value
1 to 60 minutes (1 minute increments)

P Auto Sleep (page 2-29)

6-19
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Item

Description

Auto Error Clear

If an error occurs during processing, processing stops to wait for the next step to be taken by
the user. In the Auto Error Clear mode, automatically clear the error after a set amount of time
elapses.

Value: Off, On

Error Clear Timer

If you select [On] for Auto Error Clear, set the amount of time to wait before automatically
clearing errors.

Value: 5 to 495 seconds (in 5 second increments)

NOTE

This function is displayed when [Auto Err. Clear] is set to [On].

FormFeed TimeOut

Receiving print data from the computer, the machine may sometimes wait if there is no
information signaling that the last page does not have any more data to be printed. When the
preset timeout passes, the machine automatically prints paper. The options are between 5 and
495 seconds.

Value: 5 to 495 seconds (in 5 second increments)

Sleep Level Set.

[Menu] key > [A] [ V] key > [Device Common] > [»>] key > [A] [¥] key > [Sleep Level Set.] > [»] key

Item

Description

Sleep Level (models except for
Europe)

Select the Sleep level.

Set the Energy Saver mode to reduce power consumption even more than Quick Recovery
mode.

Value: Quick Recovery, Energy Saver

Network

Set whether to use the Energy Saver mode for Network.
Value: Off, On

Card Reader™!

Set whether to use the Energy Saver mode for Card Reader.
Value: Off, On

NOTE

When the machine enters Energy Saver, the ID card cannot be recognized.

*1 Displayed only when the optional Card Authentication Kit is activated.

Power Off Rule (models for Europe)
[Menu] key > [A] [ VY] key > [Device Common] > [»>] key > [A] [¥Y] key > [Power Off Rule] > [»] key
Select whether or not the machine enters Power Off mode.

Item

Description

Network Set whether or not the machine enters Power Off mode for Network.
Value: Off, On
Even when [Network] is set to [Off], if the machine does not communicate with the other
devices, the machine will enter Power Off Mode.

USB Cable Set whether or not the machine enters Power Off mode for USB cable.

Value: Off, On

Even when [USB Cable] is set to [Off], if the machine does not communicate with the other
devices, the machine will enter Power Off Mode.
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Item Description

USB Host Set whether or not the machine enters Power Off mode for USB host.
Value: Off, On

RAM Disk Set whether or not the machine enters Power Off mode for RAM Disk.
Value: Off, On

Power Off Timer (models for Europe)
[Menu] key > [A] [ VY] key > [Device Common] > [»>] key > [A] [¥] key > [Power Off Timer] > [»>] key

Description

Power Off Timer Select whether to turn off the power automatically after a period of inactivity.

Value: 1 hour, 2 hours, 3 hours, 4 hours, 5 hours, 6 hours, 9 hours, 12 hours, 1 day,
2 days, 3 days, 4 days, 5 days, 6 days, 1 week

Disp. Status/Log
[Menu] key > [A] [V] key > [Device Common] > [»>] key > [A] [V] key > [Disp. Status/Log] > [»>] key

Item Description

Disp. Status/Log Set the display method of the Status/Log.

If the ID card authentication is enabled, this setting is applied when you refer to the print job or
print job log from Command Center RX.

JobsDetailStatus Value: Show All, My Jobs Only, Hide All

Jobs Log Value: Show All, My Jobs Only, Hide All

Low Toner Alert
[Menu] key > [A] [V] key > [Device Common] > [»>] key > [A] [V] key > [Low Toner Alert] > [»] key

Item Description

Low Toner Alert Set the amount of remaining toner to notify the administrator when to order a toner when the
toner is running low.

Value: Off, On
Low Toner Alert: Set the toner level for notification of low toner.

The setting range is 5 to 100% (in 1% increments). Displayed when
[Off/On] is set to [On] and the [ V] key is selected.

NOTE

Selecting [Off] alerts you low toner when the amount of remaining toner becomes 5%.
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Security

The security functions can be set up to protect printer operation and the print data.

I/F Block
[Menu] key > [A][V] key > [Security] > [»>] key > [A][V] key > [IIF Block] > [»>] key
This allows you to protect this machine by blocking the interface with external devices such as USB hosts.

Item Description

USB Host This locks and protects the USB port (USB host).
Value: Unblock, Block

USB Device This locks and protects the USB interface connector (USB Device).
Value: Unblock, Block
USB Drive This locks and protects the USB Port.

Value: Unblock, Block

NOTE

This function is available when USB Host is set to [Unblock].

(©) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

Security Level
[Menu] key > [A][V] key > [Security] > [»>] key > [A][V] key > [Security Level] > [OK] key

Item Description

Security Level Specify the security level.
Value:

Very High: In addition to [High] setting, this setting disables the machine settings to be
changed from external command.

High: This is the security setting we recommend. Use this setting normally.
Low: This mode is used during maintenance. Do not use normally.
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DataSanitization
[Menu] key > [A][V] key > [Security] > [»>] key > [A][V¥] key > [DataSanitization] > [OK] key

Item Description

Data Sanitization Return the following information registered in the machine to the factory defaults.
e Program
» System settings

* Optional applications
NOTE
* Print the data sanitization report and then confirm that security data is deleted.

= Print Data Sanitization Report (page 6-5)

* Once in progress, the processing cannot canceled.

» Before performing this function, disconnect network, and other cables.
« Before performing this function, set all interface block settings to [Unblock].

® |/F Block (page 6-22)

« Do not turn the power off while sanitizing the data. If the power is turned off during data
erasing, erasing will be executed automatically when the power is restored, however,
complete erasure cannot be guaranteed

Run Immediately Data Sanitization will be performed.
Schedule Completely erase address and image data saved in the device at the scheduled time.
Value: Off, On

If [On] is selected, set the date and time that sanitization is to be performed. The setting range
is Year (2000 to 2035), Month (1 to 12), Day (1 to 31), Hour (0 to 23).

Device Use The device use restriction after the data sanitization is completed. The device cannot be used if
[Prohibit] is selected.

Value: Permit, Prohibit

User/Job Account
[Menu] key > [A] [ Y] key > [User/Job Account] > [»] key
Configure settings related to machine management.

#® Overview of User Login Administration (page 7-2)

Overview of Job Accounting (page 7-6)
Unknown ID Job (page 7-21)

Op functions
[Menu] key > [A] [ Y] key > [Op functions] > [»>] key

Description

Op functions You can use the optional applications installed on this machine.
=®» Optional Applications (page 9-5)
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Administrator
[Menu] key > [A] [ VY] key > [Administrator] > [»>] key
The Administrator setting is a function that identifies a user who can use the printer and manage other users.

# Administrator settings (page 7-22)

Adjust/Maintenance
[Menu] key > [A] [ V] key > [Adjust/Maintenance] > [»>] key

Adjust printing quality and conduct machine maintenance.

Item Description

ColorCalibration This machine contains a calibration function that automatically makes adjustments to
compensate for changes that occur over time due to variations in the ambient temperature and
humidity. This function can be used for fine adjustment of tone and color drift to print in the
optimum color.

®» Color Calibration Procedure (page 8-20)

If color tone does not improve or color drift does not improve after executing this color
adjustment, refer to the following:
o Redgistration Procedure (page 8-21)

Registration Normal When first installing the machine or moving it to a new location, color drift during printing may
occur. Use this function to correct the color position of each of cyan, magenta and yellow to
Registration Details resolve color drift.

®» Reaqistration Procedure (page 8-21)

Managed by Admin In the settings, if you select this setting to [No (Home)], you can use functions that require login
as the administrator without the need for login. (The Login screen is no longer displayed.)
Select this option when the user of this machine is same as the administrator, such as when
you are using the machine in your home or a small office.

NOTE

+ If you set [Managed by Admin] to [No (Home)], you cannot use [Disp. Status/Log] and [User
Login Set.]. [User Login Set.] appears when the Card Authentication kit is activated.

* Even if you set [Managed by Admin] to [No (Home)], a login screen is displayed for
[Security Level] and [Administrator].

Value: Yes (Office), No (Home)

Restart Printer Restart the machine without turning the power switch off. Use this to deal with any unstable
operation by the machine. (Same as the computer restart.)

Service Setting Settings for machine maintenance and inspection. This menu is primarily used by servic<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>